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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact
the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the AC
adapter comply with the user-accessible surface temperature limits defined by the International Standard
for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description

Model name HP Compaq 8510w Mobile Workstation

Processors Intel® Core™ 2 Duo processors

 T7700 2.4-GHz processor 4-MB L2 cache, 800-MHz FSB

 T7500 2.2-GHz processor 4-MB L2 cache, 800-MHz FSB

 T7300 2.0-GHz processor 4-MB L2 cache, 800-MHz FSB

 T7100 1.8-GHz processor 2-MB L2 cache, 800-MHz FSB

Chipset Northbridge: Intel 965PM with iAMT support

 Southbridge: Intel ICH8M-enhanced

Graphics ATI M76M graphics card with 256 MB of graphics subsystem memory (supports
Hypermemory)

 nVidia G84GLM graphics card with 256 MB of graphics subsystem memory (supports
Turbo Cache)

 OpenGL driver support

Panels All display assemblies include 3 wireless local area network (WLAN) antennae

 15.4-inch WUXGA AntiGlare with 2 wireless wide area network (WWAN) antennae

 15.4-inch WSXGA+ AntiGlare with 2 WWAN antennae

 15.4-inch WXGA AntiGlare with 2 WWAN antennae

 15.4-inch WUXGA AntiGlare

 15.4-inch WSXGA+ AntiGlare

 15.4-inch WXGA AntiGlare

 Support privacy film

Memory 2 customer-accessible/upgradable memory module slots

 Supports dual channel memory

 Supports up to 4 GB of system RAM

 PC2-5300, 667-MHz, DDR2
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Category Description

 Supports the following configurations:

● 4096-MB total system memory (2048 × 2, dual channel)

● 3072-MB total system memory (2048 + 1024)

● 2048-MB total system memory (1024 × 2, dual channel)

● 2048-MB total system memory (2048 × 1)

● 1536-MB total system memory (1024 + 512)

● 1024-MB total system memory (512 × 2, dual channel)

● 1024-MB total system memory (1024 × 1)

● 512-MB total system memory (512 × 1)

Hard drives Supports 9.5-mm, 2.5-inch hard drives

 Customer-accessible

 Serial ATA

 Supports the following drives:

● 160-GB, 7200- and 5400-rpm

● 120-GB, 7200- and 5400-rpm

● 100-GB, 7200-rpm

● 80-GB, 7200- and 5400-rpm

Optical drives Fixed (removal of 1 screw required)

 Customer-accessible

 Parallel ATA

 Supports no-optical-drive option with blank bezel

 12.7-mm tray load

 Supports the following drives:

● DVD±RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe

● DVD±RW and CD-RW Super Multi Double-Layer Combo Drive

● DVD-CD/RW Combo Drive

● Blu-Ray DVD-RW Drive

● DVD-ROM Drive

Diskette drive Supports external USB diskette drive only

 Supports boot from external USB diskette drive

 Supports 3-mode diskette drive

Microphone Integrated microphone

Audio HD audio - ADI1981

Modem 56K V.92 1.5-inch data/fax modem with digital line guard
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Category Description

 HD audio interface

 Modem cable included in Brazil, the Czech Republic, Europe, France, Greece, Hungary,
Israel, Latin America, Poland, Russia, Saudi Arabia, Slovakia, Slovenia, South Africa,
Turkey, and the United Kingdom

Ethernet Intel 82566MM 10/100/1000 network interface card (NIC) with iAMT

 S3/S4/S5 wake on LAN: DC - no

 S3/S4/S5 wake on LAN: AC - yes

 NIC power down technology

Wireless Integrated WLAN options by way of wireless module:

 3 WLAN antennae built into display assembly

 Supports no-wireless option

 Support for the following WLAN formats:

● Intel 802.11a/b/g/n with iAMT support

● Broadcom 802.11a/b/g

● Intel 802.11a/b/g with iAMT support

● Broadcom 802.11b/g

 Integrated WWAN options by way of wireless module:

 2 WWAN 5-band antennae built into display assembly

 Subscriber identity module (SIM) security (customer-accessible in battery bay)

 Support for the following WWAN formats:

● Evolution-data optimized (EVDO)

● High-speed downlink packet access (HSDPA)

 Integrated personal area network (PAN) options by way of Bluetooth®
module:

 Supports no-WPAN option

 Broadcom Bluetooth

External media card One Type I/II PC Card slot, supporting 16-bit and 32-bit (Cardbus) PC Card modules

 Integrated Media Card Reader (supports SD and MMC)

Ports Audio-in (mono microphone)

 Audio-out (stereo headphone)

 HDMI 4

 RJ-11 (modem)

 RJ-45 (Ethernet, includes link and activity lights)

 USB (3)

 USB (1)
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Category Description

 VGA (Dsub 15-pin) supporting 1600 × 1200 external resolution at 75-GHz (hot plug with
auto-detect)

 1394

 3-pin AC power

Docking HP 3-in-1 NAS Docking Station, HP Advanced Docking Station, and HP Docking Station

Keyboard/pointing devices 12.3-inch keyboard with durable key cap coating

 Dual point (pointing stick and TouchPad) with 3 pointing stick buttons and 3 TouchPad
buttons and vertical scrolling (taps enabled as default)

 Touchpad only with 2 TouchPad buttons and vertical scrolling (taps enabled as default)

 Windows Vista Hardware Start Button

Power requirements 90-W AC adapter with localized cable plug support (3-wire plug with ground pin, supports
3-pin DC connector)

 8-cell, 2.55-Ah (73-Wh) Li-ion battery

 Support for 8-cell Extended Life Battery

 Support for 12-cell Ultra Capacity Battery

Security Integrated fingerprint reader

 Integrated smart card reader

 Security cable slot

 Trusted platform module (TPM) V.1.2

Operating system Preinstalled:

 Windows Vista™ Business 32/64

 Windows Vista Ultimate 64

 Windows® XP Professional

 FreeDOS

 Preinstalled with Microsoft Office:

 Windows Vista Business 32/64 with Office 2007 Ready

 Windows Vista Business 32/64 with Office 2007 Personal

 Windows XP Professional with Office 2007 Ready

 Windows XP Professional with Office 2007 Personal

Restore Media:

 Windows Vista Business 32/64

 Windows Vista Home 32

 Windows XP Professional

 DRDVD XP

 DRDVD Vista
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Category Description

 Supported:

 Windows Vista Enterprise

 Windows® 2000

 Certified:

 Linux

Serviceability End-user replaceable parts:

 AC adapter

 Battery (system)

 Hard drive

 Memory module

 Optical drive

 WLAN module
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2 External component identification

Display components

Item Component Function

(1) WWAN antennae (2) (select models only)* Send and receive wireless signals to communicate with
WWANs.

(2) WLAN antenna (3) (select models only)* Send and receive wireless signals to communicate with
WLANs.

(3) Ambient light sensor When activated, the sensor automatically adjusts the display
brightness based on the surrounding lighting conditions.

*The antennae are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around the
antennae free from obstructions.

To see wireless regulatory notices, refer to the section of the Regulatory, Safety and Environmental Notices that applies to your
country or region. These notices are located in Help and Support.
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Top components
Pointing devices

Item Component Function

(1) Pointing stick Moves the pointer and selects or activates items on the
screen.

(2) Left pointing stick button Functions like the left button on an external mouse.

(3) TouchPad Moves the pointer and selects or activates items on the
screen.

(4) Left TouchPad button Functions like the left button on an external mouse.

(5) Center TouchPad button Functions like the center button on an external mouse.

(6) Right TouchPad button Functions like the right button on an external mouse.

(7) TouchPad scroll zone Scrolls up or down.

(8) Right pointing stick button Functions like the right button on an external mouse.

(9) Center pointing stick button Functions like the center button on an external mouse.

NOTE: This table describes factory settings. View or change pointing device preferences as follows:

● In Windows Vista, select Start > Control Panel > Hardware and Sound > Mouse.

● In Windows XP, select Start > Control Panel > Printers and Other Hardware > Mouse.
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Buttons, switches, and fingerprint reader

Item Component Function

(1) Power button ● When the computer is off, press the button to turn on
the computer.

● When the computer is on, press the button to shut down
the computer.

● When the computer is in the Sleep state (Windows
Vista) or in Standby (Windows XP), press the button
briefly to exit the Sleep state or Standby.

● When the computer is in Hibernation, press the button
briefly to exit Hibernation.

If the computer has stopped responding and Windows®
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the computer.

To learn more about power settings, follow these steps:

● In Windows Vista, select Start > Control Panel >
System and Maintenance > Power Options.

● In Windows XP, select Start > Control Panel >
System and Maintenance > Power Options.

(2) Internal display switch Turns off the display if the display is closed while the power
is on.

(3) Info button Launches Info Center, which enables you to open various
software solutions.

(4) Wireless button Turns the wireless feature on or off, but does not establish a
wireless connection.

NOTE: A wireless network must be set up in order to
establish a wireless connection.

(5) Presentation button Starts the presentation feature.
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Item Component Function

(6) Volume mute button (select models only) Mutes and restores speaker sound.

(7) Volume scroll zone Adjusts speaker volume. Slide your finger to the left to
decrease volume and to the right to increase volume.

(8) Internal microphone Records sound.

(9) HP Fingerprint Sensor (finger print reader) Allows a fingerprint logon to Windows, instead of a
password logon.

Keys
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Function

(1) esc key Displays system information when pressed in combination
with the fn key.

(2) fn key Executes frequently used system functions when pressed in
combination with a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Embedded numeric keypad keys Can be used like the keys on an external numeric keypad.

(6) Function keys Execute frequently used system functions when pressed in
combination with the fn key.
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Lights

Item Component Function

(1) Wireless lights (2)† ● On: An integrated wireless device, such as a wireless
local area network (WLAN) device, the HP Broadband
Wireless Module, and/or a Bluetooth® device, is on.

● Off: All wireless devices are off.

(2) Power lights (2)* ● On: The computer is on.

● Blinking: The computer is in the Sleep state (Windows
Vista) or in Standby (Windows XP).

● Blinking rapidly: An AC adapter with a higher power
rating should be connected.

● Off: The computer is off or in Hibernation.

(3) Battery light ● Amber: A battery is charging.

● Green: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available
power source has reached a low battery level. When
the battery reaches a critical battery level, the battery
light begins blinking rapidly.

● Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the
computer are fully charged. If the computer is not
plugged into an external power source, the light stays
off until the battery reaches a low battery level.

(4) Drive light ● Blinking green: The hard drive or optical drive is being
accessed.

● Amber: HP 3D DriveGuard has temporarily parked the
internal hard drive.

(5) Info center light On: Info Center is on.
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Item Component Function

(6) Presentation light On: Presentation feature is on.

(7) Caps lock light On: Caps lock is on.

(8) Num lock light On: Num lock is on or the embedded numeric keypad is
enabled.

(9) Volume mute light ● Off: Computer sound is on.

● On: Computer sound is off.

(10) Volume down light Blinking: The volume scroll zone is being used to decrease
speaker volume.

(11) Volume up light Blinking: The volume scroll zone is being used to increase
speaker volume.

*The 2 power lights display the same information. The light on the power button is visible only when the computer is open. The
power light on the front of the computer is visible whether the computer is open or closed.

†The 2 wireless lights display the same information. The light on the wireless button is visible only when the computer is open.
The wireless light on the front of the computer is visible whether the computer is open or closed.

Top components 11



Front components

Item Component Function

(1) Wireless light ● On: An integrated wireless device, such as a WLAN
device, the HP Broadband Wireless Module, and/or a
Bluetooth device, is turned on.

● Off: All wireless devices are turned off.

(2) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state (Windows
Vista) or in Standby (Windows XP).

● Blinking rapidly: An AC adapter with a higher power
rating should be connected.

● Off: The computer is off or in Hibernation.

(3) Battery light ● Amber: A battery is charging.

● Green: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available
power source has reached a low battery level. When
the battery reaches a critical battery level, the battery
light begins blinking rapidly.

● Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the
computer are fully charged. If the computer is not
plugged into an external power source, the light stays
off until the battery reaches a low battery level.

(4) Drive light ● Blinking green: The hard drive or optical drive is being
accessed.

● Amber (select models only): HP 3D DriveGuard has
temporarily parked the hard drive.

(5) Speakers Produce sound.

(6) Display release latch Opens the computer.
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Left-side components

Item Component Function

(1) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

(2 RJ-45 (network) jack Connects a network cable.

NOTE: The RJ-45 (network) jack provides Gigabit Ethernet
functionality.

(3) 1394 port (select models only) Connects an optional IEEE 1394 or 1394a device, such as
a camcorder.

(4) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(5) HDMI port Connects an optional video or audio device, such as a high-
definition television, or any compatible digital or audio
component.

(6) USB ports (2) Connect optional USB devices.

(7) Media Card Reader Supports the following optional digital card formats:
MultiMedia Card (MMC) and Secure Digital (SD) Memory
Card.

(8) PC Card slot (select models only) Supports optional Type I or Type II 32-bit (CardBus) or 16-
bit PC Cards.
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Rear components

Item Component Function

(1) Power connector Connects an AC adapter.

(2) External monitor port Connects an external VGA monitor or projector.
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Right-side components

Item Component Function

(1) Audio-out (headphone) jack Produces sound when connected to optional powered stereo
speakers, headphones, ear buds, a headset, or television
audio.

(2) Audio-in (microphone) jack Connects an optional computer headset microphone, stereo
array microphone, or monaural microphone.

(3) USB ports (2) (select models only) Connect optional USB devices.

(4) Optical drive Reads optical discs and, on select models, also writes to
optical discs.

(5) RJ-11 (modem) jack Connects a modem cable.
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Bottom components

Item Component Function

(1) Hard drive bay Holds the hard drive.

(2) Accessory battery connector Connects an optional accessory battery.

(3) Battery release latches (2) Release the battery from the battery bay.

(4) Battery bay Holds the battery.

(5) SIM slot (select models only) Contains a SIM. The SIM slot is located inside the battery
bay.

(6) Docking connector Connects an optional docking device.

(7) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(8) Memory module compartment Contains 2 memory module slots.
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3 Illustrated parts catalog

Serial number location
When ordering parts or requesting information, provide the computer serial number and model number
located on the bottom of the computer.
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Computer major components
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Item Description Spare part
number

(1) Display assemblies for use with computer models equipped with WLAN and WWAN capability (includes 3 WLAN
antenna transceivers and cables and 2 WWAN antenna transceivers and cables)

 15.4-inch, WUXGA 452212-001

 15.4-inch, WSXGA+ 452211-001

 15.4-inch, WXGA 452210-001

 Display assemblies for use with computer models equipped with only WLAN capability (includes 3 WLAN antenna
transceivers and cables)

 15.4-inch, WUXGA 452209-001

 15.4-inch, WSXGA+ 452208-001

 15.4-inch, WXGA 452207-001

 Display internal components:

 Display bezel for use with computer models equipped with WLAN and WWAN capability 455078-001

 Display bezel for use with computer models equipped with only WLAN capability 452215-001

 Display enclosure for use with computer models equipped with WLAN and WWAN capability
(includes 3 WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and
cables)

452217-001

 Display enclosure for use with computer models equipped only with WLAN capability (includes
3 WLAN antenna transceivers)

452216-001

 Display hinges 452213-001

 Display inverter 452214-001

(2) Switch cover (includes LED board and cable) 452226-001

(3) Keyboards with pointing stick (include pointing stick and pointing stick cable)

 For use in Belgium 452229-A41

 For use in Brazil 452229-201

 For use in the Czech Republic 452229-221

 For use in Denmark 452229-081

 For use in France 452229-051

 For use in French Canada 452229-121

 For use in Germany 452229-041

 For use in Greece 452229-DJ1

 For use in Hungary 452229-211

 For use in Iceland 452229-DD1

 For use in Israel 452229-BB1

 For use in Italy 452229-061

 For use in Japan 452229-291

 For use in Latin America 452229-161
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Item Description Spare part
number

 For use in the Netherlands 452229-B31

 For use in Norway 452229-091

 For use in Portugal 452229-131

 For use in Russia 452229-251

 For use in Saudi Arabia 452229-171

 For use in Slovakia 452229-231

 For use in Slovenia 452229-BA1

 For use in South Korea 452229-AD1

 For use in Spain 452229-071

 For use in Sweden 452229-B71

 For use in Switzerland 452229-BG1

 For use in Taiwan 452229-AB1

 For use in Thailand 452229-281

 For use in Turkey 452229-141

 For use in the United Kingdom 452229-031

 For use in the United States 452229-001

 Keyboards without pointing stick

 For use in Belgium 452228-A41

 For use in Brazil 452228-201

 For use in the Czech Republic 452228-221

 For use in Denmark 452228-081

 For use in France 452228-051

 For use in French Canada 452228-121

 For use in Germany 452228-041

 For use in Greece 452228-DJ1

 For use in Hungary 452228-211

 For use in Iceland 452228-DD1

 For use in Israel 452228-BB1

 For use in Italy 452228-061

 For use in Japan 452228-291

 For use in Latin America 452228-161

 For use in the Netherlands 452228-B31

 For use in Norway 452228-091

 For use in Portugal 452228-131
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Item Description Spare part
number

 For use in Russia 452228-251

 For use in Saudi Arabia 452228-171

 For use in Slovakia 452228-231

 For use in Slovenia 452228-BA1

 For use in South Korea 452228-AD1

 For use in Spain 452228-071

 For use in Sweden 452228-B71

 For use in Switzerland 452228-BG1

 For use in Taiwan 452228-AB1

 For use in Thailand 452228-281

 For use in Turkey 452228-141

 For use in the United Kingdom 452228-031

 For use in the United States 452228-001

(4) TouchPads (include TouchPad cable)

 With 3 TouchPad buttons and 3 pointing stick buttons for use with keyboards with pointing stick
(includes TouchPad cable)

455969-001

 With 2 TouchPad buttons for use with keyboards without pointing stick (includes TouchPad
cable)

454248-001

(5) Top cover (includes fingerprint reader board and cable ) 452224-001

 Fingerprint reader board (not illustrated; includes fingerprint reader board cable) 455427-001

(6) RTC battery 449137-001

(7) Fan 452199-001

(8) Heat sink (includes a heat sink clip and replacement thermal material) 452227-001

 Thermal Material Kits (not illustrated)

 For use in all countries or regions except Japan and Asia countries and regions 413706-001

 For use only in Japan and Asia Pacific countries and regions 445853-001

 Plastics Kit (see Plastics Kit on page 26 for more Plastics Kit spare part information): 452221-001

(9a) PC Card slot bezel

(9b) Memory module compartment cover

(9c) Hard drive cover

 Base enclosure rubber screw covers (2, not illustrated)

 Computer feet (10, not illustrated)

(10) System board frame 455428-001

(11) WWAN modules
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Item Description Spare part
number

 HP ev2200 EVDO WWAN module 399440-001

 HP ev2210 1xEVDO-A WWAN module 451131-001

 HP hs2300 HSDPA WWAN module 448673-002

(12) WLAN modules

 Intel 802.11a/b/g/n WLAN modules:

 ● For use in Antigua and Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda,
Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican
Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India,
Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay,
the United States, Venezuela, and Vietnam

441086-001

 ● For use in Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech
Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece,
Hungary, Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania,
Luxembourg, Malta, Monaco, the Netherlands, Norway, Oman, the Philippines, Poland,
Portugal, Qatar, Romania, Russia, Serbia and Montenegro, Singapore, Slovakia,
Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey, Ukraine, the
United Kingdom, and Uzbekistan

441086-002

 ● For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South
Korea

441086-003

 ● For use in Japan 441086-291

 Broadcom 802.11a/b/g WLAN modules:

 ● For use in Canada, Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands, and the
United States

441075-001

 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia
and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina
Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad, Chile, China,
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El
Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan,
Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the
Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the
Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda,
Samoa, San Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia and
Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon
Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia,
St. Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan,
Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu,
Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan,
Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441075-002

 ● For use in Japan 441075-291

 Intel 802.11a/b/g WLAN modules:
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number

 ● For use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda,
Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican
Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India,
Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, the United
States, Uruguay, Venezuela, and Vietnam

441082-001

 ● For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the
Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece,
Hungary, Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania,
Luxembourg, Malta, Monaco, the Netherlands, Norway, Oman, the Philippines, Poland,
Portugal, Qatar, Romania, Russia, Serbia and Montenegro, Singapore, Slovakia,
Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey, Ukraine, the
United Kingdom, and Uzbekistan

441082-002

 ● For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South
Korea

441082-003

 ● For use in Japan 441082-291

 Broadcom 802.11b/g WLAN modules:

 ● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands, and
the United States

441090-001

 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia
& Herzegovina Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso,
Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, Chile,
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El
Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan,
Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the
Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic
of China, Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova,
Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi Arabia,
Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia,
Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St.
Kitts & Nevis, St. Lucia, St. Vincent & Grenada, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad & Tobago,
Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the
United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire,
Zambia, and Zimbabwe

441090-002

 ● For use in Japan 441090-291

 Intel 802.11b/g WLAN module for use in Japan 448675-004

 Intel 802.11b/g WLAN module for use in Thailand 409280-004

(13) Intel Core Duo processors  

 T7700 2.4-GHz processor (4-MB L2 cache, 800-MHz FSB) 446894-001

 T7500 2.2-GHz processor (4-MB L2 cache, 800-MHz FSB) 446893-001

 T7300 2.0-GHz processor (4-MB L2 cache, 800-MHz FSB) 446892-001
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number

 T7100 1.8-GHz processor (2-MB L2 cache, 800-MHz FSB) 446891-001

(14) Modem module

NOTE: The modem module spare part kit does not include a modem module cable. The
modem module cable is included in the Cable Kit, spare part number 452198-001. See Cable
Kit on page 27 for more Cable Kit spare part number information.

443899-001

(15) Graphics cards (include replacement thermal material)

 ATI M76M graphics card with 256 MB of graphics subsystem memory (supports Hypermemory) 454247-001

 nVidia G84GLM graphics card with 256 MB of graphics subsystem memory (supports Turbo
Cache)

455077-001

(16) PC Card assembly 455893-001

(17) System boards (include replacement thermal material)  

 For use with computer models equipped with WLAN and WWAN capability 452219-001

 For use with computer models equipped with only WLAN capability 452218-001

(18) Speaker assembly 452225-001

(19) Base enclosure (includes rubber feet) 452197-001

(20) Memory modules (PC2-5300, 667-MHz, DDR2)

 2048-MB 417506-001

 1024-MB 414046-001

 512-MB 414045-001

(21) Hard drives (include hard drive bracket)  

 160-GB, 7200-rpm 455954-001

 160-GB, 5400-rpm 443920-001

 120-GB, 7200-rpm 455079-001

 120-GB, 5400-rpm 443919-001

 100-GB, 7200-rpm 452200-001

 80-GB, 7200-rpm 445939-001

 80-GB, 5400-rpm 443918-001

(22) USB/audio board (includes USB board cable and audio board cable) 455426-001

(23) Broadcom Bluetooth modules (do not include Bluetooth module cable)

NOTE: The Bluetooth module spare part kits do not include a Bluetooth module cable. The Bluetooth module cable is
included in the Cable Kit, spare part number 452198-001. See Cable Kit on page 27 for more Cable Kit spare part
number information.

 For use in all countries and regions except Japan and Asia Pacific countries and regions 398393-002

 For use in all countries and regions except Japan and Asia Pacific countries and regions 452196-001

 For use only in Japan and Asia Pacific countries and regions 450066-001

(24) 8-cell, 2.55-Ah (73-Wh) Li-ion battery 452195-001
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(25) Optical drives (include bezel)

 DVD±RW and CD-RW Double-Layer Combo Drive with LightScribe 443903-001

 DVD±RW and CD-RW Double-Layer Combo Drive 443904-001

 Blu-Ray DVD-RW Drive 452220-001

 DVD/CD-RW Combo Drive 443901-001

 DVD-ROM Drive 443902-001

 Cable Kit (not illustrated; see Cable Kit on page 27 for more Cable Kit spare part number
information)

452198-001
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Plastics Kit

Item Description Spare part number

 Plastics Kit: 452221-001

(1) Memory module compartment cover (includes one captive screw, secured by a C-clip)

(2) Hard drive cover (includes 2 captive screws, secured by C-clips)

(3) Base enclosure screw covers (2)

(4) PC Card slot bezel

(5) Computer feet (10)
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Cable Kit

Item Description Spare part number

 Cable Kit: 452198-001

(1) Bluetooth module cable

(2) RJ-11 connector cable

(3) Microphone

(4) Modem module cable
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Mass storage devices

Item Description Spare part number

(1) Optical drives (include bezel)

 DVD±RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe 443903-001

 DVD±RW and CD-RW Super Multi Double-Layer Combo Drive 443904-001

 Blu-Ray DVD-RW Drive 452220-001

 DVD/CD-RW Combo Drive 443901-001

 DVD-ROM Drive 443902-001

(2) Hard drives (include bracket )

 160-GB, 7200-rpm 455954-001

 160-GB, 5400-rpm 443920-001

 120-GB, 7200-rpm 455079-001

 120-GB, 5400-rpm 443919-001

 100-GB, 7200-rpm 452200-001

 80-GB, 7200-rpm 445939-001

 80-GB, 5400-rpm 443918-001
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Miscellaneous parts
Description Spare part number

AC adapters

Slim 90-W AC adapter 391173-001

Smart Adapter 90-W AC adapter 416421-021

External MultiBay II 366143-001

External MultiBay II power cable and stand 366144-001

HP Extended Life Battery 367456-001

MultiBay 8X DVD-ROM Drive 373314-001

MultiBay 24X DVD/CD-RW Combo Drive 373315-001

Nylon carrying case 325814-001

USB 1.1 diskette drive 359118-001

Power cords:

For use in Australia 246959-011

For use in Brazil 246959-201

For use in Denmark 246959-081

For use in Europe, the Middle East, and Africa 246959-021

For use in Israel 246959-BB1

For use in Italy 246959-061

For use in Japan 246959-291

For use in South Korea 246959-AD1

For use in Switzerland 246959-AG1

For use in the United Kingdom 246959-031

For use the United States 246959-001

Screw Kit

● Phillips PM2.5×4.0 screw

● Phillips PM2.0×10.0 screw

● Phillips PM2.0×5.0 captive screw

● Phillips PM2.0×5.0 screw

● Phillips PM2.0×4.0 screw

● Phillips PM2.0×3.0 screw

● Phillips PM2.0×2.0 broad head screw

● Phillips PM2.0×2.0 screw

● Phillips PM1.5×3.0 screw

452222-001

Miscellaneous parts 29



Description Spare part number

● Torx T8M2.5×7.0 screw

● Torx T8M2.5×4.0 screw

● Torx T6M2.0×5.0 screw

Sequential part number listing
Spare part
number

Description

246959-001 Power cord (3-wire) for use in North America

246959-011 Power cord (3-wire) for use in Australia

246959-021 Power cord (3-wire) for use in Europe, the Middle East, and Africa

246959-031 Power cord (3-wire) for use in the United Kingdom

246959-061 Power cord (3-wire) for use in Italy

246959-081 Power cord (3-wire) for use in Denmark

246959-201 Power cord (3-wire) for use in Norway

246959-291 Power cord (3-wire) for use in Japan

246959-AD1 Power cord (3-wire) for use in South Korea

246959-AG1 Power cord (3-wire) for use in Switzerland

246959-BB1 Power cord (3-wire) for use in Israel

391173-001 Slim AC adapter, PFC 90-W

398393-002 Broadcom Bluetooth module for use in all countries and regions except Japan and Asia Pacific countries and
regions

NOTE: The Bluetooth module spare part kits do not include a Bluetooth module cable. The Bluetooth module
cable is included in the Cable Kit, spare part number 452198-001. See Cable Kit on page 27 for more Cable
Kit spare part number information.

399440-001 HP ev2200 EVDO WWAN module

409280-004 Intel 802.11b/g WLAN module for use in Thailand

413706-001 Thermal Material Kit for use in all countries and regions except Japan and Asia Pacific countries and regions

414045-001 512-MB memory module (PC2-5300, 667-MHz, DDR2)

414046-001 1024-MB memory module (PC2-5300, 667-MHz, DDR2)

416421-021 Smart AC adapter, PFC 90-W

417506-001 2048-MB memory module (PC2-5300, 667-MHz, DDR2)

441075-001 Broadcom 802.11a/b/g WLAN module for use in Canada, Cayman Islands, Guam, Puerto Rico, the U.S. Virgin
Islands, and the United States

441075-002 Broadcom 802.11a/b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua
and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Central
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number
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African Republic, Chad, Chile, China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech
Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador,
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia,
Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana,
Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan,
Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger,
Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines,
Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome &
Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia,
Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia,
St. Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo,
Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates,
the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and
Zimbabwe

441075-291 Broadcom 802.11a/b/g WLAN module for use in Japan

441082-001 Intel 802.11a/b/g WLAN module for use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados,
Bermuda, Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,
El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico, Panama,
Paraguay, Peru, Saudi Arabia, Taiwan, the United States, Uruguay, Venezuela, and Vietnam

441082-002 Intel 802.11a/b/g WLAN module for use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia,
Cyprus, the Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco, the
Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania, Russia, Serbia and
Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey,
Ukraine, the United Kingdom, and Uzbekistan

441082-003 Intel 802.11a/b/g WLAN module for use in Australia, New Zealand, Pakistan, the People's Republic of China,
and South Korea

441082-291 Intel 802.11a/b/g WLAN module for use in Japan

441086-001 Intel 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, Argentina, Aruba, the Bahamas,
Barbados, Bermuda, Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican
Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia,
Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States, Venezuela, and Vietnam

441086-002 Intel 802.11a/b/g/n WLAN module for use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia,
Cyprus, the Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco, the
Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania, Russia, Serbia and
Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey,
Ukraine, the United Kingdom, and Uzbekistan

441086-003 Intel 802.11a/b/g/n WLAN module for use in Australia, New Zealand, Pakistan, the People's Republic of
China, and South Korea

441086-291 Intel 802.11a/b/g/n WLAN module for use in Japan

441090-001 Broadcom 802.11b/g WLAN module for use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S.
Virgin Islands, and the United States

441090-002 Broadcom 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua &
Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia & Herzegovina Botswana, Brazil,
the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the
Central African Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech
Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador,
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Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia,
Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana,
Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica,
Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein,
Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall
Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger,
Nigeria, Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of China, Peru,
the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San
Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St.
Kitts & Nevis, St. Lucia, St. Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan,
Tanzania, Thailand, Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine,
the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen,
Zaire, Zambia, and Zimbabwe

441090-291 Broadcom 802.11b/g WLAN module for use in Japan

443899-001 Modem module

NOTE: The modem module spare part kit does not include a modem module cable. The modem module cable
is included in the Cable Kit, spare part number 452198-001. See Cable Kit on page 27 for more Cable Kit
spare part number information.

443901-001 DVD/CD-RW Combo Drive

443902-001 DVD-ROM Drive

443903-001 DVD±RW and CD-RW Double-Layer Combo Drive

443904-001 DVD±RW and CD-RW Double-Layer Combo Drive with LightScribe

443918-001 80-GB, 5400-rpm hard drive (includes hard drive bracket)

443919-001 120-GB, 5400-rpm hard drive (includes hard drive bracket)

443920-001 160-GB, 5400-rpm hard drive (includes hard drive bracket)

445853-001 Thermal Material Kit for use only in Japan and Asia Pacific countries and regions

445939-001 80-GB, 7200-rpm hard drive (includes hard drive bracket)

446891-001 Intel Core Duo T7700 2.4-GHz processor (4-MB L2 cache, 800-MHz FSB)

446892-001 Intel Core Duo T7500 2.2-GHz processor (4-MB L2 cache, 800-MHz FSB)

446893-001 Intel Core Duo T7300 2.0-GHz processor (4-MB L2 cache, 800-MHz FSB)

446894-001 Intel Core Duo T7100 1.8-GHz processor (4-MB L2 cache, 800-MHz FSB)

448673-002 HP hs2300 HSDPA WWAN module

448675-004 Intel 802.11b/g WLAN module for use in Japan

449137-001 RTC battery

450066-001 Broadcom Bluetooth module for use only in Japan and Asia Pacific countries and regions

NOTE: The Bluetooth module spare part kits do not include a Bluetooth module cable. The Bluetooth module
cable is included in the Cable Kit, spare part number 452198-001. See Cable Kit on page 27 for more Cable
Kit spare part number information.

451131-001 HP ev2210 1xEVDO-A WWAN module

452195-001 8-cell, 2.55-Ah (73-Wh) Li-ion battery
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Description

452196-001 Broadcom Bluetooth module for use in all countries and regions except Japan and Asia Pacific countries and
regions

NOTE: The Bluetooth module spare part kits do not include a Bluetooth module cable. The Bluetooth module
cable is included in the Cable Kit, spare part number 452198-001. See Cable Kit on page 27 for more Cable
Kit spare part number information.

452197-001 Base enclosure (includes rubber feet)

452198-001 Cable Kit (see Cable Kit on page 27 for more Cable Kit spare part information)

452199-001 Fan

452200-001 100-GB, 7200-rpm hard drive (includes hard drive bracket)

452207-001 15.4-inch WXGA display assembly for use with computer models equipped only with WLAN capability (includes
3 WLAN antenna transceivers and cables)

452208-001 15.4-inch WSXGA+ display assembly for use with computer models equipped only with WLAN capability
(includes 3 WLAN antenna transceivers)

452209-001 15.4-inch WUXGA display assembly for use with computer models equipped only with WLAN capability
(includes 3 WLAN antenna transceivers and cables)

452210-001 15.4-inch WXGA display assembly for use with computer models equipped with WLAN and WWAN capability
(includes 3 WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and cables)

452211-001 15.4-inch WSXGA+ display assembly for use with computer models equipped with WLAN and WWAN
capability (includes 3 WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and cables)

452212-001 15.4-inch WUGA display assembly for use with computer models equipped with WLAN and WWAN capability
(includes 3 WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and cables)

452213-001 Display hinges

452214-001 Display inverter

452215-001 Display bezel for use with computer models equipped with only WLAN capability

452216-001 Display enclosure for use with computer models equipped only with WLAN capability (includes 3 WLAN antenna
transceivers)

452217-001 Display enclosure for use with computer models equipped with WLAN and WWAN capability (includes 3
WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and cables)

452218-001 System board for use with computer models equipped only with WLAN capability

452219-001 System board for use with computer models equipped with WLAN and WWAN capability

452220-001 Blu-Ray DVD-RW Drive

452221-001 Plastics Kit (see Plastics Kit on page 26 for more Plastics Kit spare part information)

452222-001 Screw Kit 

452224-001 Top cover (includes fingerprint reader board and cable)

452225-001 Speaker assembly 

452226-001 Switch cover (includes LED board and cable)

452227-001 Heat sink (includes a heat sink clip and replacement thermal material)

452228-001 Keyboard without pointing stick for use in the United States

452228-031 Keyboard without pointing stick for use in the United Kingdom (includes keyboard cable)
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Spare part
number

Description

452228-041 Keyboard without pointing stick for use in Germany (includes keyboard cable)

452228-051 Keyboard without pointing stick for use in France (includes keyboard cable)

452228-061 Keyboard without pointing stick for use in Italy (includes keyboard cable)

452228-071 Keyboard without pointing stick for use in Spain (includes keyboard cable)

452228-081 Keyboard without pointing stick for use in Denmark (includes keyboard cable)

452228-091 Keyboard without pointing stick for use in Norway (includes keyboard cable)

452228-121 Keyboard without pointing stick for use in French Canada (includes keyboard cable)

452228-131 Keyboard without pointing stick for use in Portugal (includes keyboard cable)

452228-141 Keyboard without pointing stick for use in Turkey (includes keyboard cable)

452228-161 Keyboard without pointing stick for use in Latin America (includes keyboard cable)

452228-171 Keyboard without pointing stick for use in Saudi Arabia (includes keyboard cable)

452228-201 Keyboard without pointing stick for use in Brazil (includes keyboard cable)

452228-211 Keyboard without pointing stick for use in Hungary (includes keyboard cable)

452228-221 Keyboard without pointing stick for use in the Czech Republic (includes keyboard cable)

452228-231 Keyboard without pointing stick for use in Slovakia (includes keyboard cable)

452228-251 Keyboard without pointing stick for use in Russia (includes keyboard cable)

452228-281 Keyboard without pointing stick for use in Thailand (includes keyboard cable)

452228-291 Keyboard without pointing stick for use in Japan (includes keyboard cable)

452228-A41 Keyboard without pointing stick for use in Belgium (includes keyboard cable)

452228-AB1 Keyboard without pointing stick for use in Taiwan (includes keyboard cable)

452228-AD1 Keyboard without pointing stick for use in South Korea (includes keyboard cable)

452228-B31 Keyboard without pointing stick for use in the Netherlands and Europe (includes keyboard cable)

452228-B71 Keyboard without pointing stick for use in Sweden (includes keyboard cable)

452228-BA1 Keyboard without pointing stick for use in Slovenia (includes keyboard cable)

452228-BB1 Keyboard without pointing stick for use in Israel (includes keyboard cable)

452228-BG1 Keyboard without pointing stick for use in Switzerland (includes keyboard cable)

452228-DD1 Keyboard without pointing stick for use in Iceland (includes keyboard cable)

452228-DJ1 Keyboard without pointing stick for use in Greece (includes keyboard cable)

452229-001 Keyboard with pointing stick for use in the United States (includes keyboard and pointing stick cables)

452229-031 Keyboard with pointing stick for use in the United Kingdom (includes keyboard and pointing stick cables)

452229-041 Keyboard with pointing stick for use in Germany (includes keyboard and pointing stick cables)

452229-051 Keyboard with pointing stick for use in France (includes keyboard and pointing stick cables)

452229-061 Keyboard with pointing stick for use in Italy (includes keyboard and pointing stick cables)

452229-071 Keyboard with pointing stick for use in Spain (includes keyboard and pointing stick cables)
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Spare part
number

Description

452229-081 Keyboard with pointing stick for use in Denmark (includes keyboard and pointing stick cables)

452229-091 Keyboard with pointing stick for use in Norway (includes keyboard and pointing stick cables)

452229-121 Keyboard with pointing stick for use in French Canada (includes keyboard and pointing stick cables)

452229-131 Keyboard with pointing stick for use in Portugal (includes keyboard and pointing stick cables)

452229-141 Keyboard with pointing stick for use in Turkey (includes keyboard and pointing stick cables)

452229-161 Keyboard with pointing stick for use in Latin America (includes keyboard and pointing stick cables)

452229-171 Keyboard with pointing stick for use in Saudi Arabia (includes keyboard and pointing stick cables)

452229-201 Keyboard with pointing stick for use in Brazil (includes keyboard and pointing stick cables)

452229-211 Keyboard with pointing stick for use in Hungary (includes keyboard and pointing stick cables)

452229-221 Keyboard with pointing stick for use in the Czech Republic (includes keyboard and pointing stick cables)

452229-231 Keyboard with pointing stick for use in Slovakia (includes keyboard and pointing stick cables)

452229-251 Keyboard with pointing stick for use in Russia (includes keyboard and pointing stick cables)

452229-281 Keyboard with pointing stick for use in Thailand (includes keyboard and pointing stick cables)

452229-291 Keyboard with pointing stick for use in Japan (includes keyboard and pointing stick cables)

452229-A41 Keyboard with pointing stick for use in Belgium (includes keyboard and pointing stick cables)

452229-AB1 Keyboard with pointing stick for use in Taiwan (includes keyboard and pointing stick cables)

452229-AD1 Keyboard with pointing stick for use in South Korea (includes keyboard and pointing stick cables)

452229-B31 Keyboard with pointing stick for use in the Netherlands and Europe (includes keyboard and pointing stick cables)

452229-B71 Keyboard with pointing stick for use in Sweden (includes keyboard and pointing stick cables)

452229-BA1 Keyboard with pointing stick for use in Slovenia (includes keyboard and pointing stick cables)

452229-BB1 Keyboard with pointing stick for use in Israel (includes keyboard and pointing stick cables)

452229-BG1 Keyboard with pointing stick for use in Switzerland (includes keyboard and pointing stick cables)

452229-DD1 Keyboard with pointing stick for use in Iceland (includes keyboard and pointing stick cables)

452229-DJ1 Keyboard with pointing stick for use in Greece (includes keyboard and pointing stick cables)

454247-001 ATI M76M graphics card with 256 MB of graphics subsystem memory (supports Hypermemory; includes
replacement thermal material)

454248-001 TouchPad with 2 TouchPad buttons (for use with keyboards without pointing stick; includes TouchPad cable)

455077-001 nVidia G84GLM graphics card with 256 MB of graphics subsystem memory (supports Turbo Cache; includes
replacement thermal material)

455078-001 Display bezel for use with computer models equipped with WLAN and WWAN capability

455079-001 120-GB, 7200-rpm hard drive (includes hard drive bracket)

455426-001 USB/audio board (includes USB cable and audio cable)

455427-001 Fingerprint reader board (includes fingerprint reader board cable)

455428-001 System board frame
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Spare part
number

Description

455893-001 PC Card assembly

455954-001 160-GB, 7200-rpm hard drive (includes hard drive bracket)

455969-001 TouchPad with 3 TouchPad buttons and 3 pointing stick buttons (for use with keyboards with pointing stick;
includes TouchPad cable)
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4 Removal and replacement
procedures

Preliminary replacement requirements
Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Magnetic screwdriver

● Hex metric 5.0-mm nut driver

● Phillips P0 and P1 screwdrivers

● Torx T8 screwdriver

Service considerations
The following sections include some of the considerations that you must keep in mind during disassembly
and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

Using excessive force during disassembly and reassembly can damage plastic parts. Use care when
handling the plastic parts. Apply pressure only at the points designated in the maintenance instructions.
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Cables and connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with extreme
care; these cables tear easily.

Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the computer
is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and be
sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some protection,
but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you area ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described in
this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that mechanized
equipment used for moving materials is wired to ground and that proper materials are selected to
avoid static charging. When grounding is not possible, use an ionizer to dissipate electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle these
items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps) can
be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one megohm
resistance between the operator and ground. To be effective, the conductive strips must be worn in
contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Unknown user password
If the computer you are servicing has an unknown user password, follow these steps to clear the password:

NOTE: These steps also clear CMOS.

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the real-time clock (RTC) battery (see RTC battery on page 74).

6. Wait approximately 5 minutes.

7. Replace the RTC battery and reassemble the computer.

8. Connect AC power to the computer. Do not reinsert any batteries at this time.

9. Turn on the computer.

All passwords and all CMOS settings have been cleared.
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 97 screws and screw locks, in 17 different sizes, that must be removed, replaced,
or loosened when servicing the computer. Make special note of each screw and screw lock size and
location during removal and replacement.

Serial number
Report the computer serial number to HP when requesting information or ordering spare parts. The serial
number is located on the bottom of the computer.
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Computer feet
The computer feet are adhesive-backed rubber pads. The feet are included in the Plastics Kit, spare part
number 452221-001. There are 10 rubber feet that attach to the base enclosure in the locations illustrated
below.
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Battery

Description Spare part number

8-cell, 2.55-Ah (73-Wh) Li-ion battery 452195-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery:

1. Turn the computer upside down on a flat surface, with the battery bay toward you.

2. Slide the battery release latches (1) to release the battery.

3. Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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SIM
NOTE: This section applies only to computer models with WWAN capability.

NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the computer.
Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

Remove the SIM:

1. Press in on the SIM (1). (The module is partially ejected from the SIM slot.)

2. Remove the SIM (2) from the SIM slot.

Reverse this procedure to install the SIM.
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Display inverter
NOTE: If it has been determined that the display inverter is the component that must be replaced to
complete the computer repair, the display assembly does not have to be removed. Follow the procedures
in this section to replace the display inverter. For information on replacing the display assembly and the
display hinges, see Display assembly on page 75.

Description Spare part number

Display inverter (includes 2-sided tape) 452214-001

Before removing the display inverter, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

Remove the display inverter:

1. Turn the computer right-side up, with the front toward you.

2. Open the computer as far as possible.

3. Remove the two rubber screw covers (1) on the bottom edge of the display bezel.

4. Remove the two Torx T8M2.5×7.0 screws (2) that secure the display bezel bottom edge to the
display assembly.

5. Flex the inside edges of the left and right sides (1) and the display bezel bottom edge (2) until the
bezel disengages from the display assembly.

Component replacement procedures 47



6. Release the display bezel bottom edge (3) from the display assembly.

7. Remove the two Torx T8M2.5×6.0 screws (1) that secure the display inverter to the display enclosure.

8. Release the inverter (2) from the display enclosure as far as the display panel cable and backlight
cable allow.

9. Disconnect the backlight cable (3) and the display panel cable (4) from the display inverter.

10. Remove the display inverter.

Reverse this procedure to install the display inverter.
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Hard drive
NOTE: All hard drive spare part kits include a hard drive bracket.

Description Spare part number

160-GB, 7200-rpm hard drive 455954-001

160-GB, 5400-rpm hard drive 443920-001

120-GB, 7200-rpm hard drive 455079-001

120-GB, 5400-rpm hard drive 443919-001

100-GB, 7200-rpm hard drive 452200-001

80-GB, 7200-rpm hard drive 445939-001

80-GB, 5400-rpm hard drive 443918-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

Remove the hard drive:

1. Position the computer with the front toward you.

2. Loosen the two Phillips PM2.0×5.0 captive screws (1) that secure the hard drive cover to the
computer.
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3. Lift the right side of the hard drive cover (2), swing it to left, and remove the cover. The hard drive
cover is included in the Plastics Kit, spare part number 452221-001

4. Loosen the Phillips PM2.5×11.0 captive screw (1) that secures the hard drive to the computer.

5. Grasp the Mylar tab (2) on the hard drive and slide the hard drive (3) to the left to disconnect it
from the system board.

6. Remove the hard drive (4) from the hard drive bay.

7. If it is necessary to replace the hard drive bracket, remove the two Phillips PM3.0×4.0 hard drive
bracket screws (1) from each side of the hard drive.
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8. Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.
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Bluetooth module
NOTE: The Bluetooth module spare part kits do not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kit, spare part number 452198-001. See Cable Kit on page 27
for more Cable Kit spare part number information.

Description Spare part number

For use in all countries and regions except Japan and Asia Pacific countries and regions 398393-002

For use in all countries and regions except Japan and Asia Pacific countries and regions 452196-001

For use only in Japan and Asia Pacific countries and regions 450066-001

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the hard drive (see Hard drive on page 49).

Remove the Bluetooth® module:

1. Position the computer with the front toward you.

2. Release the Bluetooth module (1) from the clip in the hard drive bay by sliding it to the right.

3. Remove the Bluetooth module (2) from the hard drive bay by lifting it straight up.

4. Disconnect the Bluetooth module cable (3) from the Bluetooth module.

Reverse this procedure to reassemble and install the Bluetooth module.
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Optical drive
NOTE: All optical drive spare part kits include an optical drive bezel.

Description Spare part number

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe 443903-001

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive 443904-001

Blu-Ray DVD-RW Drive 452220-001

DVD/CD-RW Combo Drive 443901-001

DVD-ROM Drive 443902-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

Remove the optical drive:

1. Position the computer with the right side toward you.

2. Remove the Phillips PM2.5×9.0 screw (1) that secures the optical drive to the computer.

3. Push the optical drive tab (2) to release the optical drive from the computer.

4. Remove the optical drive (3) from the computer.

5. If it is necessary to replace the optical drive bracket, position the optical drive with the rear toward
you.
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6. Remove the two Phillips PM2.0×3.0 screws (1) that secure the optical drive bracket to the optical
drive.

7. Remove the optical drive bracket (2).

Reverse this procedure to install an optical drive.
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Memory module

Description Spare part number

2048-MB (PC2-5300, 667-MHz, DDR2) 417056-001

1024-MB (PC2-5300, 667-MHz, DDR2) 414046-001

512-MB (PC2-5300, 667-MHz, DDR2) 414045-001

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

Remove the memory module:

1. Position the computer with the front toward you.

2. Loosen the Phillips PM2.0×5.0 captive screw (1) that secures the memory module compartment cover
to the computer.

3. Lift the right side of the cover (2), swing it up and to the right, and remove the cover. The memory
module compartment cover is included in the Plastics Kit, spare part number 452221-001.

4. Spread the retaining tabs (1) on each side of the memory module slot to release the memory module.
(The edge of the module opposite the slot rises away from the computer.)
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5. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect installation into the
memory module slot.

Reverse this procedure to install a memory module.
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Keyboard

For use in: Spare part number For use in: Spare part number

Keyboards with pointing stick (includes pointing stick cable):

Belgium

Brazil

The Czech Republic

Denmark

France

French Canada

Germany

Greece

Hungary

Iceland

Israel

Italy

Japan

South Korea

Latin America

455529-A41

455529-201

455529-221

455529-081

455529-051

455529-121

455529-041

455529-151

455529-211

455529-DD1

455529-BB1

455529-061

455529-291

455529-AD1

455529-161

The Netherlands and Europe

Norway

Portugal

Russia

Saudi Arabia

Slovakia

Slovenia

Spain

Sweden and Finland

Switzerland

Taiwan

Thailand

Turkey

The United Kingdom

The United States

455529-021

455529-091

455529-131

455529-251

455529-171

455529-231

455529-BA1

455529-071

455529-B71

455529-111

455529-AB1

455529-281

455529-141

455529-031

455529-001

Keyboards without pointing stick:

Belgium

Brazil

The Czech Republic

Denmark

France

French Canada

Germany

Greece

Hungary

Iceland

Israel

Italy

Japan

South Korea

Latin America

455528-A41

455528-201

455528-221

455528-081

455528-051

455528-121

455528-041

455528-151

455528-211

455528-DD1

455528-BB1

455528-061

455528-291

455528-AD1

455528-161

The Netherlands and Europe

Norway

Portugal

Russia

Saudi Arabia

Slovakia

Slovenia

Spain

Sweden and Finland

Switzerland

Taiwan

Thailand

Turkey

The United Kingdom

The United States

455528-021

455528-091

455528-131

455528-251

455528-171

455528-231

455528-BA1

455528-071

455528-B71

455528-111

455528-AB1

455528-281

455528-141

455528-031

455528-001
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Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

Remove the keyboard:

1. Turn the computer upside down, with the front toward you.

2. Loosen the two Phillips PM2.5×9.0 captive screws that secure the keyboard to the computer.

3. Turn the computer display-side up, with the front toward you.

4. Open the computer as far as possible.

5. Slide the four keyboard retention tabs (1) toward you. The tabs are located between the esc and
f1 keys, between the f4 and f5 keys, between the f8 and f9 keys, and between the f12 and scroll
keys.
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6. Lift the rear edge of the keyboard (2) and slide it back until it rests on the display assembly.

7. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
disconnect the keyboard cable (2) from the system board.

8. Release the ZIF connector (3) to which the pointing stick cable is attached, and disconnect the
pointing stick cable (4) from the system board.

9. Remove the keyboard.

Reverse this procedure to install the keyboard.

WWAN module
CAUTION: The WWAN module and the WLAN module are not interchangeable.

Description Spare part number

HP ev2200 EVDO WWAN module 399440-001

HP ev2210 1xEVDO-A WWAN module 451131-001

HP hs2300 HSDPA WWAN module 448673-002
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Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the SIM (see SIM on page 46).

6. Remove the keyboard (see Keyboard on page 57).

Remove the WWAN module:

1. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The
blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

2. Remove the two Phillips PM2.5×4.0 screws (2) that secure the WWAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)

3. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

NOTE: WWAN modules are designed with a notch (4) to prevent incorrect installation.

Reverse this procedure to install the WWAN module.
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Fan

Description Spare part number

Fan 452199-001

Before removing the fan, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the keyboard (see Keyboard on page 57).

Remove the fan:

1. Disconnect the fan cable (1) from the system board.

2. Remove the two Phillips PM2.0×6.0 screws (2) that secure the fan to the base enclosure.

3. Remove the fan (3) from the base enclosure.

Reverse this procedure to install the fan.

NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the left side of
the computer.

The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is
designed to turn on automatically when high temperature conditions exist. These conditions are affected
by high external temperatures, system power consumption, power management/battery conservation
configurations, battery fast charging, and software requirements. Exhaust air is displaced through the
ventilation grill located on the left side of the computer.
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Heat sink

Description Spare part number

Heat sink (includes a heat sink clip and replacement thermal material) 452227-001

Thermal Material Kits

For use in all countries or regions except Japan and Asia countries and regions 413706-001

For use only in Japan and Asia Pacific countries and regions 445853-001

Before removing the heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the keyboard (see Keyboard on page 57).

6. Remove the fan (see Fan on page 61).

Remove the heat sink:

1. Remove the six Phillips PM2.0×3.0 screws (1) that secure the heat sink and the heat sink retention
clip to the base enclosure.

2. Release the heat sink retention clip (2) by sliding it to the right.

3. Remove the heat sink retention clip (3).

4. Lift the right side of the heat sink (1) to disengage it from the graphics card.
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5. Remove the heat sink (2) by sliding it to the right.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink (1) and
(3), the processor (2), and graphics system component (4) each time the heat sink is removed. Thermal
material is included with all heat sink and processor spare part kits.

Reverse this procedure to install the heat sink.
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Processor
NOTE: All processor spare part kits include replacement thermal material. The Thermal Material Kit is
also available using spare part numbers 413706-001 (for use in all countries or regions except Japan
and Asia countries and regions) and 445853-001 (for use only in Japan and Asia Pacific countries and
regions).

Description Spare part number

Intel Core Duo T7700 2.4-GHz processor (4-MB L2 cache, 800-MHz FSB) 446894-001

Intel Core Duo T7500 2.2-GHz processor (4-MB L2 cache, 800-MHz FSB) 446893-001

Intel Core Duo T7300 2.0-GHz processor (4-MB L2 cache, 800-MHz FSB) 446892-001

Intel Core Duo T7100 1.8-GHz processor (2-MB L2 cache, 800-MHz FSB) 446891-001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the following components:

a. Keyboard (see Keyboard on page 57)

b. Fan (see Fan on page 61)

c. Heat sink (see Heat sink on page 62)

Remove the processor:

1. Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn counterclockwise
until you hear a click.
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2. Lift the processor (2) straight up and remove it.

NOTE: The gold triangle (3) on the processor must be aligned with the triangle (4) embossed on
the processor slot when you install the processor.

Reverse this procedure to install the processor.

Graphics card
NOTE: All graphics card spare part kits include replacement thermal material.

Description Spare part number

ATI M76M graphics card with 256 MB of graphics subsystem memory (supports Hypermemory) 454247-001

nVidia G84GLM graphics card with 256 MB of graphics subsystem memory (supports Turbo Cache) 455077-001

Thermal Material Kits

For use in all countries or regions except Japan and Asia countries and regions 413706-001

For use only in Japan and Asia Pacific countries and regions 445853-001

Before removing the graphics card, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.
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4. Remove the battery (see Battery on page 45).

5. Remove the following components:

a. Keyboard (see Keyboard on page 57)

b. Fan (see Fan on page 61)

c. Heat sink (see Heat sink on page 62)

Remove the graphics card:

1. Remove the two Phillips PM2.0×3.0 screws (1) that secure the graphics card to the computer. (The
edge of the board opposite the graphics card slot rises away from the computer.)

2. Remove the graphics card (2) by sliding it away from the graphics card slot at an angle.

NOTE: The graphics card is designed with a notch (3) to prevent incorrect installation.

Reverse this procedure to install the graphics card.
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TouchPad
NOTE: All TouchPad spare part kits include a TouchPad cable. The TouchPad cable is also included in
the Cable Kit, spare part number 452198-001.

Description Spare part number

With 3 TouchPad buttons and 3 pointing stick buttons for use with keyboards with pointing stick 455969-001

With 2 TouchPad buttons for use with keyboards without pointing stick 454248-001

Before removing the TouchPad, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the keyboard (see Keyboard on page 57).

Remove the TouchPad:

1. Turn the computer upside down, with the front toward you.

2. Remove the Torx T8M2.5×9.0 screw that secures the TouchPad to the computer.

3. Turn the computer right side up, with the front toward you.

4. Lift the rear edge of the TouchPad (1) until it disengages from the top cover.
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5. Release the TouchPad (2) by sliding it toward the display.

6. Disconnect the TouchPad cable (1) from the system board.

7. Remove the TouchPad (2).

Reverse this procedure to install the TouchPad.
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WLAN module
CAUTION: The WLAN module and the WWAN module are not interchangeable.

Description Spare part number

Intel 802.11a/b/g/n WLAN modules:

● For use in Antigua and Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,
El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia,
Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States,
Venezuela, and Vietnam

441086-001

● For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech
Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta,
Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania,
Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka,
Sweden, Switzerland, Turkey, Ukraine, the United Kingdom, and Uzbekistan

441086-002

● For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South Korea 441086-003

● For use in Japan 441086-291

Broadcom 802.11a/b/g WLAN modules:

● For use in Canada, Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands, and the United
States

441075-001

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape
Verde, the Central African Republic, Chad, Chile, China, Colombia, Comoros, the Congo, Costa
Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia,
Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar,
Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan,
Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein,
Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali,
Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco,
Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles,
the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau,
Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic
of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi
Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia,
Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts &
Nevis, St. Lucia, St. Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu,
Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan,
Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441075-002

● For use in Japan 441075-291

Intel 802.11a/b/g WLAN modules:

● For use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,
El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia,
Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, the United States, Uruguay,
Venezuela, and Vietnam

441082-001

● For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech
Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,

441082-002
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Description Spare part number

Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta,
Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania,
Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka,
Sweden, Switzerland, Turkey, Ukraine, the United Kingdom, and Uzbekistan

● For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South Korea 441082-003

● For use in Japan 441082-291

Broadcom 802.11b/g WLAN modules:

● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands, and the
United States

441090-001

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia & Herzegovina Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon,
Cape Verde, the Central African Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa
Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia,
Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar,
Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica,
Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the
Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of China,
Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia,
Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia and
Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands,
Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent &
Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand,
Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the
United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe

441090-002

● For use in Japan 441090-291

Intel 802.11b/g WLAN module for use in Japan 448675-004

Intel 802.11b/g WLAN module for use in Thailand 409280-004

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the keyboard (see Keyboard on page 57).

6. Remove the TouchPad (see TouchPad on page 67).
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Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The
white WLAN antenna cable is connected to the WLAN module “Aux” terminal. If the computer is
equipped with an 802.11a/b/g/n WLAN module, the yellow WLAN antenna cable (2) is
connected to the middle terminal on the WLAN module.

2. Remove the two Phillips PM2.5×4.0 screws (3) that secure the WLAN module to the computer. (The
edge of the module opposite the slot rises away from the computer.)

3. Remove the WLAN module (4) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch (5) to prevent incorrect installation.

Reverse this procedure to install the WLAN module.

Switch cover

Description Spare part number

Switch cover (includes LED board and cable) 452226-001

Before removing the switch cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the keyboard (see Keyboard on page 57).
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Remove the switch cover:

1. Turn the computer upside down, with the front toward you.

2. Remove the Torx T8M2.5×9.0 screw (1) and the three Phillips PM2.0×2.0 screws (2) that secure
the switch cover to the computer.

3. Turn the computer right-side up, with the front toward you.

4. Open the computer as far as possible.

5. Release the switch cover by lifting the left and right edges of the switch cover (1) until the switch
cover disengages from the computer.

6. Lift the switch cover (2) up and back.
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7. Release the ZIF connector (1) to which the LED board cable is attached, and disconnect the LED
board cable (2) from the connector.

8. Remove the switch cover.

Reverse this procedure to install switch cover.
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RTC battery
NOTE: Removing the RTC battery and leaving it uninstalled for 5 or more minutes causes all passwords
and CMOS settings to be cleared.

Description Spare part number

RTC battery 449137-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the memory module (see Memory module on page 55).

Remove the RTC battery:

1. Disconnect the RTC battery cable (1) from the system board.

2. Remove the RTC battery (2) from the clip built into the top cover.

Reverse this procedure to install the RTC battery.
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Display assembly

Description Spare part number

Display assemblies for use with computer models equipped with WLAN and WWAN capability (includes 3 WLAN antenna
transceivers and cables and 2 WWAN antenna transceivers and cables)

15.4-inch, WUXGA 452212-001

15.4-inch, WSXGA+ 452211-001

15.4-inch, WXGA 452210-001

Display assemblies for use with computer models equipped with only WLAN capability (includes 3 WLAN antenna transceivers
and cables)

15.4-inch, WUXGA 452209-001

15.4-inch, WSXGA+ 452208-001

15.4-inch, WXGA 452207-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Disconnect the wireless antenna cables from the WLAN module (see WLAN module on page 69)
and the WWAN module (see WWAN module on page 59).

6. Remove the following components:

a. Keyboard (see Keyboard on page 57)

b. Switch cover (see Switch cover on page 71)

Remove the display assembly:

1. Disconnect the display panel cable (1) from the system board.
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2. Remove the wireless antenna cables from the clips (2) and (3) and routing channels (4) built into
the top cover.

3. Remove the following screws:

(1) Two Torx T8M2.5×9.0 screws

(2) One Phillips PM2.5×4.0 screw

(3) Two Phillips PM2.0×2.0 screws

4. Position the computer with the rear panel toward you.

5. Remove the four Torx T8M2.5×9.0 screws (1) that secure the display assembly to the computer.

76 Chapter 4   Removal and replacement procedures



6. Lift the display assembly (2) straight up and remove it.

CAUTION: When installing the display assembly, be sure that the 4 wireless antenna cables
routed out of the display right hinge are routed and arranged properly. Each antenna cable has an
exposed section of cable and a metallic grounding sleeve (1). The grounding sleeve must completely
cover the exposed section of cable. Each cable must be secured inside a space in the copper
grounding clip (2). Left to right, the cables must be installed in a white, yellow, red, black sequence.

Failure to follow these routing instructions can result in degradation of the computer's WLAN and
WWAN performance.
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7. If it is necessary to replace the display bezel or display hinges, remove the following:

(1) Four rubber screw covers on the display bezel top edge

(2) Two rubber screw covers on the display bezel bottom edge

(3) Four Torx T8M2.5×6.0 screws on the display bezel top edge

(4) Two Torx T8M2.5×7.0 screws on the display bezel bottom edge

NOTE: See Display inverter on page 47 for display inverter replacement instructions.

8. Flex the inside edges of the left and right sides (1) and the top and bottom sides (2) of the display
bezel until the bezel disengages from the display enclosure.

9. Remove the display bezel (3). The display bezel is available using spare part numbers 455078-001
(for use with computer models equipped with WLAN and WWAN capability) and 452215-001 (for
use with computer models equipped with only WLAN capability).

10. If it is necessary to replace the display hinges, remove the six Torx T8M2.5×6.0 screws (1) that
secure the display panel to the display enclosure.
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11. Remove the display panel (2).

12. Remove the four Phillips PM2.0×4.0 screws (1) that secure each display hinge to the display
panel.

13. Remove the display hinges (2). The left and right display hinges are available using spare part
number 452213-001.

Reverse this procedure to reassemble and install the display assembly.
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Top cover

Description Spare part number

Top cover (includes fingerprint reader board and cable) 452224-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the following components:

a. Hard drive (see Hard drive on page 49)

b. Optical drive (see Optical drive on page 53)

c. Keyboard (see Keyboard on page 57)

d. Switch cover (see Switch cover on page 71)

e. TouchPad (see TouchPad on page 67)

f. Display assembly (see Display assembly on page 75)

Remove the top cover:

1. Turn the computer upside down, with the front toward you.

2. Remove the two rubber screw covers (1). The rubber screw covers are included in the Plastics Kit,
spare part number 452221-001.

3. Remove the ten Torx T8M2.5×9.0 screws (2) that secure the top cover to the base enclosure.
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4. Turn the computer right-side up, with the front toward you.

5. Disconnect the fingerprint reader board cable (1) from the system board.

6. Remove the two Torx T8M2.5×7.0 screws (2) and the four Phillips PM2.5×3.0 screws (3) that secure
the top cover to the computer.

7. Lift the rear edge of the top cover (1) and swing it up and forward until it rests at an angle.

8. Disconnect the microphone cable (2) from the system board.

9. Remove the top cover (3).

10. If it is necessary to replace the microphone, turn the top cover upside down with the front toward
you.

11. Remove the microphone cable from the clips (1) built into the top cover.
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12. Remove the microphone receiver (2) from the clip (3) built into the top cover.

Reverse this procedure to install the top cover.

Speaker assembly

Description Spare part number

Speaker assembly 452225-001

Before removing the speaker assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the following components:

a. Hard drive (see Hard drive on page 49)

b. Optical drive (see Optical drive on page 53)

c. Keyboard (see Keyboard on page 57)

d. Switch cover (see Switch cover on page 71)

e. TouchPad (see TouchPad on page 67)

f. Display assembly (see Display assembly on page 75)

g. Top cover (see Top cover on page 80)
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Remove the speaker assembly:

1. Disconnect the speaker cable (1) from the system board.

2. Remove the three Phillips PM2.5×4.0 screws (2) that secure the speaker assembly to the base
enclosure.

3. Remove the speaker assembly (3) from the base enclosure.

Reverse this procedure to install the speaker assembly.
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Modem module
NOTE: The modem module spare part kit does not include a modem module cable. The modem module
cable is included in the Cable Kit, spare part number 452198-001. See Cable Kit on page 27 for more
Cable Kit spare part number information.

Description Spare part number

Modem module 443899-001

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the following components:

a. Hard drive (see Hard drive on page 49)

b. Optical drive (see Optical drive on page 53)

c. Keyboard (see Keyboard on page 57)

d. Switch cover (see Switch cover on page 71)

e. TouchPad (see TouchPad on page 67)

f. Display assembly (see Display assembly on page 75)

g. Top cover (see Top cover on page 80)

h. Speaker assembly (see Speaker assembly on page 82)

Remove the modem module:

1. Remove the two Phillips PM2.5×4.0 screws (1) that secure the modem module to the system board.

2. Disconnect the modem module (2) from the system board by lifting it straight up.
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3. Disconnect the modem module cable (3) from the system board.

Reverse this procedure to install the modem module.

System board and system board frame
NOTE: All system board spare part kits include replacement thermal material. The Thermal Material Kit
is also available using spare part numbers 413706-001 (for use in all countries or regions except Japan
and Asia countries and regions) and 445853-001 (for use only in Japan and Asia Pacific countries and
regions).

Description Spare part number

For use with computer models equipped with WLAN and WWAN capability 452219-001

For use with computer models equipped with only WLAN capability 452218-001

System board frame 455428-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the following components:

a. Hard drive (see Hard drive on page 49)

b. Optical drive (see Optical drive on page 53)

c. Keyboard (see Keyboard on page 57)

d. Fan (see Fan on page 61)
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e. Heat sink (see Heat sink on page 62)

f. Switch cover (see Switch cover on page 71)

g. TouchPad (see TouchPad on page 67)

h. Display assembly (see Display assembly on page 75)

i. Top cover (see Top cover on page 80)

j. Speaker assembly (see Speaker assembly on page 82)

k. Modem module (see Modem module on page 84)

When replacing the system board, be sure that the following components are removed from the defective
system board and installed on the replacement system board:

● SIM (see SIM on page 46)

● Memory module (see Memory module on page 55)

● WLAN module (see WLAN module on page 69)

● WWAN module (see WWAN module on page 59)

● Processor (see Processor on page 64)

● Graphics card (see Graphics card on page 65)

● PC Card assembly (see PC Card assembly on page 89)

Remove the system board:

1. Disconnect the following cables from the system board:

(1) RJ-11 connector cable

(2) USB board cable

(3) Audio board cable

(4) Bluetooth module cable

2. Position the base enclosure with the rear panel toward you.
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3. Remove the four black Phillips PM2.5×7.0 screws (1) and the four silver Phillips PM2.5×7.0
screws (2) that secure the system board frame to the base enclosure.

4. Lift the system board (3) and frame straight up and remove them from the base enclosure.

NOTE: When removing the system board and frame, be sure that the USB/audio board cables
(4) route cleanly through the opening in the system board frame.

5. Remove the silver Phillips PM2.5×7.0 screw (1) and the two HM5.0×9.0 screw locks (2) that secure
the system board to the system board frame.

6. Lift the front edge of the system board (1) until the it clears the right side of the system board
frame (2).
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7. Remove the system board (3) from the system board frame by sliding it forward.

Reverse the preceding procedure to install the system board.

RJ-11 connector cable
NOTE: The RJ-11 connector cable is included in the Cables Kit, spare part number 452198-001.

Before removing the RJ-11 connector cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the following components:

a. Hard drive (see Hard drive on page 49)

b. Optical drive (see Optical drive on page 53)

c. Keyboard (see Keyboard on page 57)

d. Fan (see Fan on page 61)

e. Heat sink (see Heat sink on page 62)

f. Switch cover (see Switch cover on page 71)

g. TouchPad (see TouchPad on page 67)

h. Display assembly (see Display assembly on page 75)

i. Top cover (see Top cover on page 80)

j. Speaker assembly (see Speaker assembly on page 82)
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k. Modem module (see Modem module on page 84)

l. System board (see System board and system board frame on page 85)

Remove the RJ-11 connector cable:

1. Remove the RJ-11 connector (1) from the clip built into the base enclosure.

2. Remove the RJ-11 connector cable from the clips and routing channel (2) built into the base enclosure.

3. Remove the RJ-11 connector cable from the base enclosure.

Reverse this procedure to install the RJ-11 connector cable.

PC Card assembly

Description Spare part number

PC Card assembly 455893-001

Before removing the PC Card assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the following components:

a. Hard drive (see Hard drive on page 49)

b. Optical drive (see Optical drive on page 53)

c. Keyboard (see Keyboard on page 57)

Component replacement procedures 89



d. Fan (see Fan on page 61)

e. Heat sink (see Heat sink on page 62)

f. Switch cover (see Switch cover on page 71)

g. TouchPad (see TouchPad on page 67)

h. Display assembly (see Display assembly on page 75)

i. Top cover (see Top cover on page 80)

j. Speaker assembly (see Speaker assembly on page 82)

k. Modem module (see Modem module on page 84)

l. System board (see System board and system board frame on page 85)

Remove the PC Card assembly:

1. Turn the system board upside down, with the front toward you.

2. Remove the two Phillips PM2.0×3.0 screws that secure the PC Card assembly to the system board.

3. Detach the slots on the PC Card assembly from the tabs on the PC Card connector (1).
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4. Remove the PC Card assembly (2).

Reverse this procedure to install the PC Card assembly.

USB/audio board

Description Spare part number

USB/audio board (includes USB cable and audio cable) 455426-001

Before removing the USB/audio board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the following components:

a. Hard drive (see Hard drive on page 49)

b. Optical drive (see Optical drive on page 53)

c. Keyboard (see Keyboard on page 57)

d. Fan (see Fan on page 61)

e. Heat sink (see Heat sink on page 62)

f. Switch cover (see Switch cover on page 71)

g. TouchPad (see TouchPad on page 67)

h. Display assembly (see Display assembly on page 75)
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i. Top cover (see Top cover on page 80)

j. Speaker assembly (see Speaker assembly on page 82)

k. Modem module (see Modem module on page 84)

l. System board (see System board and system board frame on page 85)

Remove the USB/audio board:

1. Remove the two Phillips PM2.5×4.0 screws (1) that secure the USB/audio board to the base
enclosure.

2. Lift the left side of the USB/audio board (2) until the USB and audio connectors disengage from the
openings in the base enclosure.

3. Remove the USB/audio board and cables from the base enclosure.

Reverse this procedure to install the USB/audio board.
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5 Computer Setup

Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system is
not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: Pointing devices are not supported in Computer Setup. You must use the keyboard to navigate
and make selections.

NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB legacy
support is enabled.

To start Computer Setup:

1. Turn on or restart the computer.

2. Before Windows® opens and while the "F10 = ROM Based Setup" message is displayed in the
lower-left corner of the screen, press f10.
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Using Computer Setup
Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

Because Computer Setup is not Windows-based, it does not support the TouchPad. Navigation and
selection are by keystroke:

● To choose a menu or a menu item, use the arrow keys.

● To select an item, press enter.

● To close open dialog boxes and return to the main Computer Setup screen, press esc.

● To view navigation information, press f1.

● To change the language, press f2.

2. Select the File, Security, Diagnostics, or System Configuration menu.

3. To exit Computer Setup, choose one of the following methods:

● To exit Computer Setup without saving your preferences, use the arrow keys to select File >
Ignore Changes and Exit. Then follow the instructions on the screen.

● To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes and Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

Restoring factory settings in Computer Setup
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select File > Restore defaults, and then press enter.

3. When the confirmation dialog box opens, press f10.

4. To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes and Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your
computer.

File menu

Select To do this

System information ● View identification information for the computer and the batteries in the system.

● View specification information for the processor, cache and memory size,
system ROM, video revision, and keyboard controller version.

Restore defaults Replace the configuration settings in Computer Setup with the original factory
settings. (Password settings and security settings are not changed when you restore
the factory settings.)

Ignore changes and exit Cancel any changes entered during the current session. Then exit and restart the
computer.

Save changes and exit Save any changes entered during the current session. Then exit and restart the
computer. Your changes go into effect when the computer restarts.
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Security menu

Select To do this

Setup password Enter, change, or delete a setup password.

Power-On password Enter, change, or delete a power-on password.

Password options ● Enable/disable stringent security.

● Enable/disable password requirement on computer restart.

DriveLock passwords ● Enable/disable DriveLock on any computer hard drive and on optional
MultiBay hard drives.

● Change a DriveLock user password or master password.

NOTE: DriveLock settings are accessible only when you enter Computer Setup by
turning on (not restarting) the computer.

Smart Card security Enable/disable support for smart card and Java™ Card power-on authentication.

NOTE: Power-on authentication for smart cards is supported only on computers
with optional smart card readers.

NOTE: You must have an administrator password to change this setting.

TPM Embedded Security Enable/disable support for Trusted Platform Module (TPM) Embedded Security,
which protects the computer from unauthorized access to owner functions available
in Embedded Security for ProtectTools. For more information, refer to the
ProtectTools software Help.

NOTE: You must have a setup password to change this setting.

System IDs Enter user-defined computer asset tracking number and ownership tag.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary hard drive. The
following options are available:

● Fast: Runs the Disk Sanitizer erase cycle once.

● Optimum: Runs the Disk Sanitizer erase cycle 3 times.

● Custom: Allows you to select the desired number of Disk Sanitizer erase cycles
from a list.

CAUTION: If you run Disk Sanitizer, the data on the primary hard drive is
destroyed permanently.

Diagnostics menu

Select To do this

Hard Drive Self-Test options Run a comprehensive self-test on any hard drive in the system.

Memory Check Run a comprehensive check on system memory.

Startup Check (select models only) Verify the system components needed for starting the computer.
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System Configuration menu
NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language (or press f2) Change the Computer Setup language.

Boot options ● Set f9, f10, and f12 delay when starting up.

● Enable/disable CD-ROM boot.

● Enable/disable floppy boot.

● Enable/disable internal network adapter boot and set the boot mode (PXE or
RPL).

● Enable/disable MultiBoot, which sets a boot order that can include most boot
devices in the system.

● Set the Express Boot Popup delay in seconds.

● Set the boot order.

Device configurations ● Swap the functions of the fn key and left ctrl key.

● Enable/disable multiple standard pointing devices at startup. (To set the
computer to support only a single, usually nonstandard, pointing device at
startup, select Disable.)

● Enable/disable USB legacy support. When enabled, USB legacy support
allows the following:

◦ Use of a USB keyboard, mouse, and hub in Computer Setup even when
a Windows operating system is not running.

◦ Startup from bootable USB devices, including a hard drive, diskette drive,
or optical drive connected by a USB port to the computer or to an optional
docking device (select models only).

● Select a parallel port mode: EPP (Enhanced Parallel Port), standard,
bidirectional, or ECP (Enhanced Capabilities Port).

● Enable/disable BIOS DMA data transfers.

● Enable/disable fan always on while connected to an AC outlet.

● Enable/disable Intel® Data Execution Prevention or AMD® PSAE Execution
Disable. When enabled, the processor can disable some virus code execution,
which helps to improve computer security.

● Enable/disable LAN Power Save. When enabled, saves power by turning off
the LAN when not in use.

● Enable/disable SATA Native Mode.

● Enable/disable Dual Core CPU.

● Enable/disable Secondary Battery Fast Charge.

● Choose Bit-shift or LBA assisted HDD Translation Mode.

● Enable/disable Windows direct application launcher.

● Enable/disable HP Lockout.

Computer Setup menus 97



Select To do this

Built-In Device Options ● Enable/disable embedded WWAN Device Radio.

● Enable/disable embedded WLAN Device Radio.

● Enable/disable embedded Bluetooth® Device Radio.

● Enable/disable LAN/WLAN Switching. When enabled, switches to a WLAN
when a LAN is either unavailable or disconnected.

● Enable/disable Wake on LAN from Off.

● Enable/disable the ambient light sensor.

Port Options ● Enable/disable the serial port.

● Enable/disable the parallel port.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables MultiBay II devices and
ExpressCard devices on the advanced port replicator.

● Enable/disable the 1394 port.

● Enable/disable the cardbus slot.

● Enable/disable the ExpressCard slot.

● Enable/disable the infrared port.

● Enable/disable the optical disk drive.

● Enable/disable the network controller.
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6 Specifications

Computer specifications
 Metric U.S.

Dimensions

Length 26.0 cm 10.24 in

Width 35.7 cm 14.00 in

Height (front to rear) 2.8 to 3.4 cm 1.10 to 1.34 in

Weight (equipped with optical drive, 8-cell battery, one 512-
MB memory module, pointing stick, and TouchPad)

2.77 kg 6.1 lbs

Input power

Operating voltage 19.0 V dc @ 4.74 A – 90 W

Operating current 4.74 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F

Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating (14.7 to 10.1 psia) -15 m to 3,048 m 50 ft to 10,000 ft

Nonoperating (14.7 to 4.4 psia) -15 m to 12,192 m -50 ft to 40,000 ft

Shock

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine

Random vibration

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep
rate
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Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this
range of temperatures.

15.4.-inch, WUXGA display specifications
 Metric U.S.

Dimensions

Height 20.7 cm 8.15 in

Width 33.1 cm 13.03 in

Diagonal 39.1 cm 15.39 in

Number of colors Up to 16.8 million

Contrast ratio 200:1 (typical)

Brightness 180 nits (typical)

Pixel resolution

Pitch 0.197 × 0.197 mm

Format 1920 × 1200

Configuration RGB vertical stripe

Backlight CCFT

Character display 80 × 25

Total power consumption 7.0 W

Viewing angle +/-40 horizontal, +/–50° vertical (typical)
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15.4-inch, WSXGA+ display specifications
 Metric U.S.

Dimensions

Height 20.7 cm 8.15 in

Width 33.1 cm 13.03 in

Diagonal 39.1 cm 15.39 in

Number of colors Up to 16.8 million

Contrast ratio 200:1 (typical)

Brightness 180 nits (typical)

Pixel resolution

Pitch 0.197 × 0.197 mm

Format 1680 × 1050

Configuration RGB vertical stripe

Backlight CCFT

Character display 80 × 25

Total power consumption 7.0 W

Viewing angle +/-40 horizontal, +/–50° vertical (typical)
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15.4-inch, WXGA display specifications
 Metric U.S.

Dimensions

Height 20.7 cm 8.15 in

Width 33.1 cm 13.03 in

Diagonal 39.1 cm 15.39 in

Number of colors Up to 16.8 million

Contrast ratio 200:1 (typical)

Brightness 180 nits (typical)

Pixel resolution

Pitch 0.197 × 0.197 mm

Format 1366 × 768

Configuration RGB vertical stripe

Backlight CCFT

Character display 80 × 25

Total power consumption 7.0 W

Viewing angle +/-40 horizontal, +/–50° vertical (typical)
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Hard drive specifications
 160-GB* 120-GB* 100-GB* 80-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm 70 mm

Weight 101 g 101 g 101 g 101 g

Interface type SATA SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 3 ms 3 ms 3 ms 3 ms

Average 13 ms 13 ms 13 ms 13 ms

Maximum 24 ms 24 ms 24 ms 24 ms

Logical blocks 312,560,640 234,420,480 195,350,400 156,280,320

Disc rotational speed 7200 and 5400
rpm

7200 and 5400
rpm

7200 rpm 5400 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive specifications
may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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DVD±RW and CD-RW Double-Layer Combo Drive
specifications

Applicable disc Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-ROM,
CD-ROM XA, MIXED MODE CD, CD-I, CD-I
Bridge (Photo-CD, Video CD), Multisession CD
(Photo-CD, CD-EXTRA, Portfolio, CD-R, CD-RW),
CD-R, CD-RW, DVD-ROM (DVD-5, DVD-9,
DVD-10, DVD-18), DVD-R, DVD-RW, DVD+R,
DVD+RW, DVD-RAM

Write:

CD-R and CD-RW

DVD+R, DVD+RW, DVD-R, DVD-
RW, DVD-RAM

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc 12 cm (4.72 in)

Mini disc 8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random < 175 ms < 230 ms

Full stroke < 285 ms < 335 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

Transfer mode Multiword DMA Mode

Startup time < 15 seconds

Stop time < 6 seconds
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DVD/CD-RW Combo Drive specifications
Applicable disc Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-ROM,
CD-ROM XA, MIXED MODE CD, CD-I, CD-I
Bridge (Photo-CD, Video CD), Multisession CD
(Photo-CD, CD-EXTRA, Portfolio, CD-R, CD-RW),
CD-R, CD-RW, DVD-ROM (DVD-5, DVD-9,
DVD-10, DVD-18), DVD-R, DVD-RW, DVD+R,
DVD+RW, DVD-RAM

Write:

CD-R and CD-RW

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc 12 cm (4.72 in)

Mini disc 8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random < 110 ms < 130 ms

Full stroke < 210 ms < 225 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 2 MB

Data transfer rate  

24X CD-ROM 3,600 KB/sec

8X DVD 3,600 KB/sec

24X CD-R 3,600 KB/sec

24X CD-RW 3,600 KB/sec

Transfer mode Multiword DMA mode 2

Startup time < 15 seconds

Stop time < 6 seconds
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DVD-ROM Drive
Applicable disc DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2), CD Digital

Audio, CD-XA ready (Mode 2, Form 1 and Form 2), CD-I (Mode 2, Form 1 and Form 2),
CD-R, CD-RW, Photo CD (single and multisession), CD-Bridge

Center hole diameter 1.5 cm (0.59 in)

Disc diameter  

Standard disc

Mini disc

12 cm (4.72 in)

8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random < 100 ms < 125 ms

Full stroke < 175 ms < 225 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 512 KB

Data transfer rate  

CD-R (24X) 3600 KB/s (150 KB/s at 1X CD rate)

CD-RW (10X) 1500 KB/s (150 KB/s at 1X CD rate)

CD-ROM (24X) 3600 KB/s (150 KB/s at 1X CD rate)

DVD (8X) 10,800 KB/s (1,352 KB/s at 1X DVD rate)

Multiword DMA mode 2 16.6 MB/s

Startup time < 10 seconds

Stop time < 3 seconds
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System DMA specifications
Hardware DMA System function

DMA0 Not applicable

DMA1* Not applicable

DMA2* Not applicable

DMA3 Not applicable

DMA4 Direct memory access controller

DMA5* Available for PC Card

DMA6 Not assigned

DMA7 Not assigned

*PC Card controller can use DMA 1, 2, or 5.
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System interrupt specifications
Hardware IRQ System function

IRQ0 System timer

IRQ1 Standard 101-/102-Key or Microsoft® Natural Keyboard

IRQ2 Cascaded

IRQ3 Intel 82801DB/DBM USB2 Enhanced Host Controller—24CD

IRQ4 COM1

IRQ5* Conexant AC—Link Audio Intel 82801DB/DBM SMBus Controller—24C3 Data Fax
Modem with SmartCP

IRQ6 Diskette drive

IRQ7* Parallel port

IRQ8 System CMOS/real-time clock

IRQ9* Microsoft ACPI-compliant system

IRQ10* Intel USB UHCI controller—24C2

Intel 82852/82855 GM/GME Graphic Controller

Realtek RTL8139 Family PCI Fast Ethernet Controller

IRQ11 Intel USB EHCI controller—24CD

Intel USB UHCI controller—24C4

Intel USB UHCI controller—24C7

Intel Pro/Wireless 2200BG

TI OHCI 1394 host controller

TI PCI1410 CardBus controller

IRQ12 Synaptics PS/2 TouchPad

IRQ13 Numeric data processor

IRQ14 Primary IDE channel

IRQ15 Secondary IDE channel

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQ9, IRQ10, or none.

NOTE: PC Cards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or IRQ15. Either the infrared or the serial port
may assert IRQ3 or IRQ4.

108 Chapter 6   Specifications



System I/O address specifications
I/O address (hex) System function (shipping configuration)

000 - 00F DMA controller no. 1

010 - 01F Unused

020 - 021 Interrupt controller no. 1

022 - 024 Opti chipset configuration registers

025 - 03F Unused

02E - 02F 87334 “Super I/O” configuration for CPU

040 - 05F Counter/timer registers

044 - 05F Unused

060 Keyboard controller

061 Port B

062 - 063 Unused

064 Keyboard controller

065 - 06F Unused

070 - 071 NMI enable/RTC

072 - 07F Unused

080 - 08F DMA page registers

090 - 091 Unused

092 Port A

093 - 09F Unused

0A0 - 0A1 Interrupt controller no. 2

I/O Address (hex) System Function (shipping configuration)

0A2 - 0BF Unused

0C0 - 0DF DMA controller no. 2

0E0 - 0EF Unused

0F0 - 0F1 Coprocessor busy clear/reset

0F2 - 0FF Unused

100 - 16F Unused

170 - 177 Secondary fixed disk controller

178 - 1EF Unused

1F0 - 1F7 Primary fixed disk controller

1F8 - 200 Unused

201 JoyStick (decoded in ESS1688)

202 - 21F Unused
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I/O address (hex) System function (shipping configuration)

220 - 22F Entertainment audio

230 - 26D Unused

26E - 26 Unused

278 - 27F Unused

280 - 2AB Unused

2A0 - 2A7 Unused

2A8 - 2E7 Unused

2E8 - 2EF Reserved serial port

2F0 - 2F7 Unused

2F8 - 2FF Infrared port

300 - 31F Unused

320 - 36F Unused

370 - 377 Secondary diskette drive controller

378 - 37F Parallel port (LPT1/default)

380 - 387 Unused

388 - 38B FM synthesizer—OPL3

38C - 3AF Unused

3B0 - 3BB VGA

3BC - 3BF Reserved (parallel port/no EPP support)

3C0 - 3DF VGA

3E0 - 3E1 PC Card controller in CPU

3E2 - 3E3 Unused

3E8 - 3EF Internal modem

3F0 - 3F7 “A” diskette controller

3F8 - 3FF Serial port (COM1/default)

CF8 - CFB PCI configuration index register (PCIDIVO-1)

CFC - CFF PCI configuration data register (PCIDIVO-1)

110 Chapter 6   Specifications



System memory map specifications
Size Memory address System function

640 KB 00000000-0009FFFF Base memory

128 KB 000A0000-000BFFFF Video memory

48 KB 000C0000-000CBFFF Video BIOS

160 KB 000C8000-000E7FFF Unused

64 KB 000E8000-000FFFFF System BIOS

15 MB 00100000-00FFFFFF Extended memory

58 MB 04800000-07FFFFFF Super extended memory

58 MB 04800000-07FFFFFF Unused

2 MB 08000000-080FFFFF Video memory (direct access)

4 GB 08200000-FFFEFFFF Unused

64 KB FFFF0000-FFFFFFFF System BIOS
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7 Screw listing

This section provides specification and reference information for the screws and screw locks used in the
computer. All screws listed in this section are available in the Screw Kit, spare part number 452222-001.
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Phillips PM2.0×5.0 captive screw

Color Quantity Length Thread Head diameter

Black 3 5.0 mm 2.0 mm 4.5 mm

Where used:

(1) Two screws that secure the hard drive cover to the computer (screws are captured on the cover by C-
clips)

(2) One screw that secures the memory module compartment cover to the computer (screw is captured
on the cover by a C-clip)
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Phillips PM2.0×11.0 captive screw

Color Quantity Length Thread Head diameter

Silver 1 11.0 mm 2.0 mm 5.0 mm

Where used: One screw that secures the hard drive to the computer
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Phillips PM3.0×4.0 screw

Color Quantity Length Thread Head diameter

Silver 4 4.0 mm 3.0 mm 5.0 mm

Where used: 4 screws that secure the hard drive bracket to the hard drive
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Torx T8M2.5×9.0 screw

Color Quantity Length Thread Head diameter

Black 19 9.0 mm 2.5 mm 5.0 mm

Where used:

(1) One screw that secures the optical drive to the computer

(2) One screw that secures the TouchPad to the computer

(3) One screw that secures the switch cover to the computer
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Where used: 2 screws that secure the display assembly to the computer

Where used: 4 screws that secure the display assembly to the computer

Where used: 10 screws that secure the top cover to the base enclosure
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Silver Phillips PM2.0×3.0 screw

Color Quantity Length Thread Head diameter

Silver 10 3.0 mm 2.0 mm 4.5 mm

Where used: 2 screws that secure the optical drive bracket to the optical drive
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Where used: 6 screws that secure the heat sink to the system board

Where used: 2 screws that secure the graphics card to the system board
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Phillips PM2.5×9.0 captive screw

Color Quantity Length Thread Head diameter

Black 2 9.0 mm 2.5 mm 5.0 mm

Where used: 2 captive screws that secure the keyboard to the computer
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Phillips PM2.0×6.0 screw

Color Quantity Length Thread Head diameter

Silver 2 6.0 mm 2.0 mm 4.5 mm

Where used: 2 screws that secure the fan to the base enclosure
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Phillips PM2.5×4.0 screw

Color Quantity Length Thread Head diameter

Black 10 4.0 mm 2.5 mm 5.0 mm

Where used:

(1) Two screws that secure the WWAN module to the computer

(2) Two screws that secure the WLAN module to the computer
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Where used: One screw that secures the display assembly to the computer

Where used: 3 screws that secure the speaker assembly to the base enclosure
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Where used: 2 screws that secure the modem module to the system board

Phillips PM2.0×2.0 screw

Color Quantity Length Thread Head diameter

Black 5 2.0 mm 2.0 mm 4.5 mm

Where used: 3 screws that secure the switch cover to the computer
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Where used: 2 screws that secure the display assembly to the computer

Torx T8M2.5×6.0 screw

Color Quantity Length Thread Heat width

Black 10 6.0 mm 2.5 mm 5.0 mm

Where used: 4 screws that secure the display bezel top edge to the display assembly
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Where used:

(1) Two screws that secure the display inverter to the display enclosure

(2) Four screws that secure the display panel to the display enclosure
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Torx T8M2.5×7.0 screw

Color Quantity Length Thread Head diameter

Silver 2 7.0 mm 2.5mm 5.0 mm

Where used: 2 screws that secure the display bezel bottom edge to the display enclosure
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Phillips PM2.0×4.0 screw

Color Quantity Length Thread Head diameter

Silver 8 4.0 mm 2.0 mm 4.5 mm

Where used: 8 screws that secure the display hinges to the display panel
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Black Phillips PM2.5×7.0 screw

Color Quantity Length Thread Head diameter

Black 6 7.0 mm 2.5 mm 5.0 mm

Where used: 2 screws that secure the top cover to the base enclosure
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Where used: 4 screws that secure the system board frame to the base enclosure

Phillips PM2.5×3.0 screw

Color Quantity Length Thread Head diameter

Silver 4 3.0 mm 2.5 mm 5.0 mm

Where used: 4 screws that secure the top cover to the base enclosure
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Silver Phillips PM2.5×7.0 screw

Color Quantity Length Thread Head diameter

Silver 5 7.0 mm 2.5 mm 5.0 mm

Where used: 4 screws that secure the system board frame to the base enclosure

Where used: One screw that secures the system board to the system board frame
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Hex Metric HM5.0×10.0 screw lock

Color Quantity Length Thread Head diameter

Silver 2 10.0 mm 3.0 mm 5.0 mm

Where used: 2 screw locks that secure the system board to the system board frame
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Black Phillips PM2.0×3.0 screw

Color Quantity Length Thread Head diameter

Black 4 3.0 mm 2.0 mm 4.5 mm

Where used: 2 screws that secure the PC Card assembly to the system board

Where used: 2 screws that secure the USB/audio board to the base enclosure
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8 Backup and recovery in
Windows Vista

Creating recovery discs
After setting up the computer for the first time, be sure to create a set of recovery discs of the full factory
image. The recovery discs are used to start up (boot) the computer and recover the operating system and
software to factory settings in case of system instability or failure.

Note the following guidelines before creating recovery discs:

● Use any of the following types of discs: CD-R, DVD+R, DVD+R DL, DVD-R, or DVD-R DL (purchased
separately). The discs you use will depend on the type of optical drive installed in your computer.
Because DVDs store more information than CDs, DVDs and DVDs with double-layer (DL) support
reduce the number of discs required.

NOTE: Read-write discs, such as CD-RW, DVD+RW, and DVD-RW, are not compatible with the
HP Backup & Recovery Manager software.

● The computer must be connected to AC power during the process.

● Only one set of the recovery discs can be created per computer.

● Number each disc before inserting it into the optical drive of the computer.

● If necessary, you can cancel the disc creation before you have finished creating the recovery discs.
The next time you select Create a set of recovery discs (Recommended), you will be
prompted to continue the disc creation.

To create a set of recovery discs:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery
Manager.

2. Click Next.

3. Click Create a set of recovery discs (Recommended), and then click Next.

4. Follow the on-screen instructions.
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Backing up your information
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup & Recovery Manager to create an entire drive backup as soon as you set up your computer.

With HP Backup & Recovery Manager, you can perform the following tasks:

● Backing up your information regularly to protect your important system files

● Creating system recovery points that allow you to reverse undesireable changes to your computer
by restoring the computer to an earlier state

● Scheduling backups at specific intervals or events

When to back up
● On a regularly scheduled basis

NOTE: Set reminders to back up your information periodically.

● Before the computer is repaired or restored

● Before you add or modify hardware or software

Backup suggestions
● Create a set of recovery discs using HP Backup & Recovery Manager.

● Create system recovery points using HP Backup & Recovery Manager, and periodically copy them
to disc.

● Store personal files in the Documents folder and back up these folders periodically.

● Back up templates stored in their associated programs.

● Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your settings.

The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen.

b. Copy the screen.

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, and then select Edit > Paste.

NOTE: Before you can perform backup and recovery procedures, the computer must be connected to
external power.

NOTE: Drivers, utilities, and software installed by HP can be copied to a CD or to a DVD using HP
Backup & Recovery Manager.
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Backing up specific files or folders
You can back up specific files or folders to the recovery partition on the hard drive, to an optional external
hard drive, or to optical discs (CDs or DVDs).

NOTE: This process will take several minutes, depending on the file size and the speed of the computer.

To back up specific files or folders:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery
Manager.

2. Click Next.

3. Click Create or manage backups, and then click Next.

4. Click Back up user created files and folders, and then click Next.

5. Follow the on-screen instructions.

Backing up the entire hard drive
When you perform a complete backup of the hard drive, you are saving the full factory image, including
the Windows® operating system, software, and all personal files and folders.

NOTE: A copy of the entire hard drive image can be stored on another hard drive, on a network drive,
or on recovery discs that you create.

NOTE: This process may take over an hour, depending on your computer speed and the amount of
data being stored.

To back up your entire hard drive:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery
Manager.

2. Click Next.

3. Click Create or manage backups, and then click Next.

4. Click Create or manage Entire Drive Backups, and then click Next.

5. Follow the on-screen instructions.
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Creating recovery points
When you back up modifications since your last backup, you are creating system recovery points. This
allows you to save a snapshot of your hard drive at a specific point in time. You can then recover back
to that point if you want to reverse subsequent changes made to your system.

NOTE: The first system recovery point, a snapshot of the entire image, is automatically created the first
time you perform a backup. Subsequent recovery points make copies of changes made after that time.

HP recommends that you create recovery points at the following times:

● Before you add or extensively modify software or hardware

● Periodically, whenever the system is performing optimally

NOTE: Recovering to an earlier recovery point does not affect data files or e-mails created since that
recovery point.

To create a system recovery point:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery
Manager.

2. Click Next.

3. Click Create or manage backups, and then click Next.

4. Click Create or manage Recovery Points, and then click Next.

5. Follow the on-screen instructions.

Scheduling backups
Use HP Backup Scheduler to schedule backups for the entire system, for recovery points, or for specific
files and folders. With this tool, you can schedule backups at specific intervals (daily, weekly, or monthly)
or at specific events, such as at system restart or when you dock to an optional docking station (select
models only).

To schedule backups:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup Scheduler.

2. Follow the on-screen instructions.
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Performing a recovery
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup & Recovery Manager to create an entire drive backup as soon as you set up your computer.

HP Backup & Recovery Manager helps you with the following tasks for safeguarding your information
and restoring it in case of a system failure:

● Recovering important files—This feature helps you reinstall important files without performing a full
system recovery.

● Performing a full system recovery—With HP Backup & Recovery Manager, you can recover your full
factory image if you experience system failure or instability. HP Backup & Recovery Manager works
from a dedicated recovery partition on the hard drive or from recovery discs you create.

Performing a recovery from the recovery discs
To perform a recovery from the recovery discs, follow these steps:

1. Back up all personal files.

2. Insert the first recovery disc into the optical drive and restart the computer.

3. Follow the on-screen instructions.

Performing a recovery from the hard drive
There are 2 ways to initiate a recovery from the hard drive:

● From within Windows

● From the recovery partition
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Initiating a recovery in Windows

To initiate a recovery in Windows, follow these steps:

1. Back up all personal files.

2. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery
Manager.

3. Click Next.

4. Click Perform a recovery, and then click Next.

5. Follow the on-screen instructions.

Initiating a recovery from the hard drive recovery partition

To initiate a recovery from the hard drive recovery partition, follow these steps:

1. Back up all personal files.

2. Restart the computer, and then press f11 before the Windows operating system loads.

3. Click a recovery option, and then click Next.

4. Follow the on-screen instructions.
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9 Backup and recovery in
Windows XP

Creating recovery discs
After setting up the computer for the first time, be sure to create a set of recovery discs of the full factory
image. The recovery discs are used to start up (boot) the computer and recover the operating system and
software to factory settings in case of system instability or failure.

Note the following guidelines before creating recovery discs:

● Use any of the following types of discs: CD-R, DVD+R, DVD+R DL, DVD-R, or DVD-R DL (purchased
separately). The discs you use will depend on the type of optical drive installed in your computer.
Because DVDs store more information than CDs, DVDs and DVDs with double-layer (DL) support
reduce the number of discs required.

NOTE: Read-write discs, such as CD-RW, DVD+RW, and DVD-RW, are not compatible with the
HP Backup and Recovery Manager software.

● The computer must be connected to AC power during the process.

● Only one set of the recovery discs can be created per computer.

● Number each disc before inserting it into the optical drive of the computer.

● If necessary, you can cancel the disc creation before you have finished creating the recovery discs.
The next time you select Create factory software recovery CDs or DVDs to recover the
system (Highly recommended), you will be prompted to continue the disc creation.

To create a set of recovery discs:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

2. Click Next.

3. Click Create factory software recovery CDs or DVDs to recover the system (Highly
recommended), and then click Next.

4. Follow the on-screen instructions.
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Backing up your information
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup and Recovery Manager to create an entire drive backup as soon as you set up your computer.

With HP Backup and Recovery Manager, you can perform the following tasks:

● Backing up your information regularly to protect your important system files

● Creating system recovery points that allow you to reverse undesireable changes to your computer
by restoring the computer to an earlier state

● Scheduling backups at specific intervals or events

When to back up
● On a regularly scheduled basis

NOTE: Set reminders to back up your information periodically.

● Before the computer is repaired or restored

● Before you add or modify hardware or software

Backup suggestions
● Create a set of recovery discs using HP Backup and Recovery Manager.

● Create system recovery points using HP Backup and Recovery Manager, and periodically copy them
to disc.

● Store personal files in the My Documents folder and back up these folders periodically.

● Back up templates stored in their associated programs.

● Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your settings.

The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen.

b. Copy the screen.

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, and then select Edit > Paste.

NOTE: Before you can perform backup and recovery procedures, the computer must be connected to
external power.

NOTE: Drivers, utilities, and software installed by HP can be copied to a CD or to a DVD using HP
Backup and Recovery Manager.
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Backing up specific files or folders
You can back up specific files or folders to the recovery partition on the hard drive, to an optional external
hard drive, or to optical discs (CDs or DVDs).

NOTE: This process will take several minutes, depending on the file size and the speed of the computer.

To back up specific files or folders:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

2. Click Next.

3. Click Back up to protect system settings and important data files, and then click
Next.

4. Click Back up individual files and folders, and then click Next.

5. Follow the on-screen instructions.

Backing up the entire hard drive
When you perform a complete backup of the hard drive, you are saving the full factory image, including
the Windows® operating system, software, and all personal files and folders.

NOTE: A copy of the entire hard drive image can be stored on another hard drive, on a network drive,
or on recovery discs that you create.

NOTE: This process may take over an hour, depending on your computer speed and the amount of
data being stored.

To back up your entire hard drive:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

2. Click Next.

3. Click Back up to protect system settings and important data files, and then click
Next.

4. Click Back up entire hard drive, and then click Next.

5. Follow the on-screen instructions.
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Creating recovery points
When you back up modifications since your last backup, you are creating system recovery points. This
allows you to save a snapshot of your hard drive at a specific point in time. You can then recover back
to that point if you want to reverse subsequent changes made to your system.

NOTE: The first system recovery point, a snapshot of the entire image, is automatically created the first
time you perform a backup. Subsequent recovery points make copies of changes made after that time.

HP recommends that you create recovery points at the following times:

● Before you add or extensively modify software or hardware

● Periodically, whenever the system is performing optimally

NOTE: Recovering to an earlier recovery point does not affect data files or e-mails created since that
recovery point.

To create a system recovery point:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

2. Click Next.

3. Click Back up to protect system settings and important data files, and then click
Next.

4. Click Create or manage Recovery Points, and then click Next.

5. Follow the on-screen instructions.

Scheduling backups
Use HP Backup Scheduler to schedule backups for the entire system, for recovery points, or for specific
files and folders. With this tool, you can schedule backups at specific intervals (daily, weekly, or monthly)
or at specific events, such as at system restart or when you dock to an optional docking station (select
models only).

To schedule backups:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup Scheduler.

2. Follow the on-screen instructions.
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Performing a recovery
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup and Recovery Manager to create an entire drive backup as soon as you set up your computer.

HP Backup and Recovery Manager helps you with the following tasks for safeguarding your information
and restoring it in case of a system failure:

● Recovering important files—This feature helps you reinstall important files without performing a full
system recovery.

● Performing a full system recovery—With HP Backup and Recovery Manager, you can recover your
full factory image if you experience system failure or instability. HP Backup and Recovery Manager
works from a dedicated recovery partition on the hard drive or from recovery discs you create.

Performing a recovery from the recovery discs
To perform a recovery from the recovery discs, follow these steps:

1. Back up all personal files.

2. Insert the first recovery disc into the optical drive and restart the computer.

3. Follow the on-screen instructions.

Performing a recovery from the hard drive
There are 2 ways to initiate a recovery from the hard drive:

● From within Windows

● From the recovery partition
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Initiating a recovery in Windows

To initiate a recovery in Windows, follow these steps:

1. Back up all personal files.

2. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

3. Click Next.

4. Click Recover important files or the entire system, and then click Next.

5. Follow the on-screen instructions.

Initiating a recovery from the hard drive recovery partition

To initiate a recovery from the hard drive recovery partition, follow these steps:

1. Back up all personal files.

2. Restart the computer, and then press f11 before the Windows operating system loads.

3. Click a recovery option, and then click Next.

4. Follow the on-screen instructions.
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10 Connector pin assignments

Audio-out (headphone)

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground

Audio-in (microphone)

Pin Signal

1 Audio signal in

2 Audio signal in

3 Ground
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External monitor

Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock
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RJ-11 (modem)

Pin Signal

1 Unused

2 Tip

3 Ring

4 Unused

5 Unused

6 Unused

RJ-45 (network)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused
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Universal Serial Bus

Pin Signal

1 +5 VDC

2 Data -

3 Data +

4 Ground
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11 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to 120
volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the country
or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or region
where the computer is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for evaluation
in the country or region  where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage rating
of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard
Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions
Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

Korea EK 4

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding
type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and
wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be
used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and
wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be
used.
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12 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general household
waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this appendix can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the backlight.
Careful handling must be exercised when removing these components. When you remove these
components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly
that might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or see
the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this appendix are general disassembly instructions. Specific details,
such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one
computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of the
display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.

156 Chapter 12   Recycling



18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Index

Symbols/Numerics
1394 port 13

A
AC adapter, spare part

numbers 29,  30
accessory battery connectort 16
ambient light sensor, location 6
antennae, disconnecting 60,  71
audio, product description 2
audio-in jack

location 15
pin assignments 146

audio-out jack
location 15
pin assignments 146

B
backing up 135,  141
backup

files and folders 136,  142
hard drive 136,  142
modifications made to the

system 137,  143
scheduling 137,  143

base enclosure screw cover,
illustrated 26

base enclosure, spare part
number 24,  33

battery
location 16
removal 45
spare part number 24,  32, 

45
battery bay 16
battery latches 16
battery light 10,  12

Bluetooth module
removal 52
spare part numbers 24,  30, 

32,  33,  52
Bluetooth module cable,

illustrated 27
boot options 97
boot order 97
bottom components 16
buttons

info 8
pointing stick 7
power 8
presentation 8
TouchPad 7
volume mute 9
wireless 8

C
Cable Kit

contents 27
spare part number 25,  27, 

33
cables, service considerations 38
caps lock light 11
carrying case, spare part

number 29
chipset, product description 1
CMOS clearing 42
components

bottom 16
buttons 8
display 6
fingerprint reader 8
front 12
keys 9
left-side 13
lights 10
pointing devices 7
rear 14

right-side 15
switch 8
top 7

computer feet
illustrated 26
locations 44
spare part number 44

Computer Setup
accessing 93
Diagnostics menu 96
File menu 95
navigating and selecting 94
restoring factory settings 94
Security menu 96
System Configuration menu 97
using 94

computer specifications 99
connectors

docking 16
power 14
service considerations 38

creating recovery points 137, 
143

D
Diagnostics menu 96
Disk Sanitizer 96
diskette drive

precautions 38
product description 2
spare part number 29

display assembly
removal 75
spare part numbers 19,  33, 

75
display bezel

release 47
removal 78
spare part numbers 19,  33, 

35,  78
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display component recycling 152
display components 6
display enclosure, spare part

numbers 19,  33
display hinge

removal 79
spare part number 19,  33, 

79
display inverter

removal 47
spare part number 19,  47

display panel
product description 1
removal 78

display release latch 12
display specifications 100,  101, 

102
display switch 8
docking connector 16
docking support, product

description 4
drive light 10,  12
DriveLock password 96
drives

boot order 97
preventing damage 38

DVD-ROM Drive
precautions 38
removal 53
spare part number 25,  28, 

29,  32,  53
specifications 106

DVD-RW Drive
precautions 38
removal 53
spare part number 25,  28, 

33,  53
specifications 104

DVD/CD-RW Combo Drive
precautions 38
removal 53
spare part number 25,  28, 

29,  32,  53
specifications 105

DVD±RW and CD-RW Combo Drive
precautions 38
removal 53
spare part numbers 25,  28, 

32,  53
specifications 104

E
electrostatic discharge 39
esc key 9
Ethernet, product description 3
Execution Disable 97
external media cards, product

description 3
external monitor port

location 14
pin assignments 147

External MultiBay II power cable
and stand, spare part
number 29

External MultiBay II, spare part
number 29

F
fan

removal 61
spare part number 21,  33, 

61
feet

illustrated 26
locations 44
spare part number 44

File menu 95
fingerprint reader board, spare part

number 21,  35
fn key 9
front components 12
function keys 9

G
graphics card

removal 65
spare part numbers 24,  35, 

65
graphics, product description 1
grounding equipment and

methods 41

H
hard drive

location 16
precautions 38
product description 2
removal 49
spare part numbers 24,  28, 

32,  33,  35,  36,  49
specifications 103

hard drive backup 136,  142

hard drive bay 16
hard drive bracket, removal 51
hard drive cover

illustrated 26
removal 50

hard drive recovery 138,  144
hard drive test 96
HDMI port 13
headphone jack

location 15
pin assignments 146

heat sink
removal 62
spare part number 21,  33, 

62
hinge

removal 79
spare part number 19,  33, 

79
HP Extended Life Battery, spare part

number 29
HP Fingerprint Sensor 9

I
I/O address specifications 109
info button 8
info center light 10
interrupt specifications 108
inverter

removal 47
spare part number 33,  47

J
jacks

audio-in 15
audio-out 15
headphone 15
microphone 15
modem 15
network 13
RJ-11 15
RJ-45 13

K
keyboard

product description 4
removal 57
spare part numbers 19,  20, 

33,  34,  57
keypad keys 9
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keys
esc 9
fn 9
function 9
keypad 9
Windows applications 9
Windows logo 9

L
LAN Power Save 97
language, changing in Computer

Setup 97
left-side components 13
legacy support, Universal Serial Bus

(USB) 93,  97
lights

battery 10,  12
caps lock 11
drive 10,  12
info center 10
num lock 11
power 10,  12
Presentation 11
volume down 11
volume mute 11
volume up 11
wireless 10,  12

M
mass storage devices, spare part

numbers 28
Media Card Reader 13
memory check 96
memory map specifications 111
memory module

product description 1
removal 55
spare part numbers 24,  30, 

55
memory module compartment 16
memory module compartment cover

illustrated 26
removal 55

microphone
illustrated 27
location 9
product description 2

microphone jack
location 15
pin assignments 146

model name 1
modem jack

location 15
pin assignments 148

modem module
product description 2
removal 84
spare part number 24,  32, 

84
modem module cable,

illustrated 27
monitor port

location 14
pin assignments 147

N
navigating in Computer Setup 94
network jack

location 13
pin assignments 148

num lock light 11

O
operating system, product

description 4
optical drive

location 15
precautions 38
product description 2
removal 53
spare part numbers 25,  28, 

53
specifications 104,  105, 

106

P
packing guidelines 40
parallel port mode 97
password clearing 42
passwords 96
PC Card assembly

removal 89
spare part number 24,  36, 

89
PC Card slot 13
PC Card slot bezel, illustrated 26
pin assignments

audio-in jack 146
audio-out jack 146
external monitor port 147
headphone jack 146

microphone jack 146
modem jack 148
monitor port 147
network jack 148
RJ-11 148
RJ-45 jack 148
Universal Serial Bus (USB)

port 149
plastic parts 37
Plastics Kit

contents 26
spare part number 21,  26, 

33
pointing device

components 7
illustrated 7
product description 4

pointing device components
pointing stick 7
pointing stick buttons 7
TouchPad 7
TouchPad buttons 7
TouchPad scroll zone 7

pointing stick 7
pointing stick buttons 7
ports

1394 13
external monitor 14
HDMI 13
monitor 14
product description 3
Universal Serial Bus (USB) 13, 

15
power button 8
power connector 14
power cord

set requirements 150
spare part numbers 29,  30

power light 10,  12
power requirements, product

description 4
power-on password 96
presentation button 8
Presentation light 11
processor

product description 1
removal 64
spare part numbers 23,  32, 

64
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product description
audio 2
chipset 1
diskette drive 2
display panel 1
docking support 4
Ethernet 3
external media cards 3
graphics 1
hard drives 2
keyboard 4
memory module 1
microphone 2
model name 1
modem module 2
operating system 4
optical drives 2
pointing devices 4
ports 3
power requirements 4
processors 1
security 4
serviceability 5
wireless 3

R
rear components 14
recovery discs

creating 134,  140
using 138,  144

recovery partition 139,  145
recovery points 137,  143
removal/replacement

preliminaries 37
procedures 43

restoring Computer Setup factory
settings 94

right-side components 15
RJ-11 connector cable

illustrated 27
removal 88

RJ-11 jack
location 15
pin assignments 148

RJ-45 jack
location 13
pin assignments 148

RTC battery
removal 74
spare part number 21,  32, 

74

S
scheduling backups 137,  143
Screw Kit

contents 112
spare part number 29,  33

screw listing 112
security cable slot 13
Security menu 96
security, product description 4
selecting in Computer Setup 94
serial number 17,  43
service considerations 37
serviceability, product

description 5
SIM

removal 46
slot 16

smart card security 96
speaker assembly

removal 82
spare part number 24,  33, 

82
speakers 12
specifications

computer 99
display 100,  101,  102
DVD-ROM Drive 106
DVD-RW Drive 104
DVD/CD-RW Combo

Drive 105
DVD±RW and CD-RW Combo

Drive 104
hard drive 103
I/O addresses 109
interrupts 108
memory map 111
optical drive 104,  105,  106
system DMA 107

startup check 96
static-shielding materials 41
stringent security 96
switch cover

removal 71
spare part number 19,  33, 

71

system backup 136,  142
system board

removal 85
spare part numbers 24,  33, 

85
system board frame

removal 85,  88
spare part number 21,  35, 

85
System Configuration menu 97
system DMA 107
system fan 97
system information 95
system memory map 111
system recovery points 137,  143

T
Thermal Material Kit, spare part

numbers 21,  30,  32,  62,  65
thermal material, replacement 63
tools required 37
top components 7
top cover

removal 80
spare part number 21,  33, 

80
TouchPad

removal 67
spare part numbers 21,  35, 

36,  67
TouchPad buttons 7
TouchPad scroll zone 7
transporting guidelines 40

U
Universal Serial Bus (USB) legacy

support 97
Universal Serial Bus (USB) port

location 13,  15
pin assignments 149

unknown password 42
USB legacy support 93
USB/audio board

removal 91
spare part number 24,  35, 

91

V
vents 13,  16
volume down light 11
volume mute button 9
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volume mute light 11
volume scroll zone 9
volume up light 11

W
Windows applications key 9
Windows logo key 9
wireless antennae,

disconnecting 60,  71
wireless button 8
wireless light 10,  12
wireless, product description 3
WLAN antennae, locations 6
WLAN module

removal 69
spare part numbers 22,  30, 

32,  69
workstation guidelines 40
WWAN antennae, locations 6
WWAN module

removal 59
spare part numbers 21,  30, 

32,  59
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